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[bookmark: _Toc109603194]فصل اول: مدلهای خود رگرسیون برداری VAR







[bookmark: _Toc109603195]مقدمه
مدلهای خودرگرسیون برداری[footnoteRef:1] (VARs) معمولاً برای پیشبینی سیستمهای سری زمانی مورد استفاده قرار میگیرد. همچنین برای تحلیل تاثیرات پویای اختلالات تصادفی بر روی سیستم متغیرها نیز کاربرد داد.  [1:  Vector Autoregression] 

در ادامه، توضیحات مختصری از ویژگیهای مهم مدلهای VAR ارائه میشود. برای مطالعه بیشتر در زمینه مبانی تجزیه و تحلیل VAR میتوانید به لوتکافل[footnoteRef:2] (2006) مراجعه کنید که توضیحات گستردهای در زمینه تجزیه و تحلیل مدلهای VAR ارائه داده است. مدلهای VAR در میتوان بهصورت زیر نوشت: [2:  Lütkepohl] 

[image: ] (1)
در اینجا داریم: 
[image: ] یک بردار K * 1 از متغیرهای وابسته است.
[image: ] یک بردار K * 1 از متغیرهای مستقل است.
[image: ]ماتریس K*K وقفههای ضرایب است که باید برآورد شود.
C ماتریس K*d ضرایب متغیرهای مستقل است که باید برآورد شوند.
[image: ] نیز یک فرایند وایت نویز با مشخصات زیر است:
[image: ] (2)
[bookmark: _Toc109603196]کار با نرمافزار
[bookmark: _Toc109603197]برآورد یک مدل VAR 
برای تصریح یک مدل VAR باید ابتدا یک آبجکت VAR ایجاد کنید. مسیر:
Quick > Estimate VAR
را از منوی ایویوز طی کنید تا پنجره مربوط به مدل VAR باز شود. البته میتوانید با تایپ عبارت var در نوار فرمان و کلیک گزینه Enter نیز به این پنجره رسید. پنجره اصلی و گزینههای مدل VAR بهصورت زیر است:
[image: ]
ابتدا با یک فرم کاهش یافته VAR شروع میکنیم. پنجره مربوط به مدل VAR را به صورت مناسب با مدل پر کنید:
· در ابتدا نوع مدل VAR را از بخش VAR Taype  انتخاب کنید (به عنوان مثال روش Standard VAR)
· در بخش Estimation Sample نمونه مورد نظر خود را انتخاب کنید. میتوانید این دوره زمانی را در صورتی که مایل باشید تعدیل کنید.
· لیست متغیرهای وابسته K را در فیلد Endogenous Variables وارد کنید.
· در این مثال متغیرهای وابسته شامل M1, IP, و TB3 است.
· تعداد وقفهها را در بخش Lag Intervals for Endogenous وارد کنید. این اطلاعات به صورت جفتی وارد میشود. در اینجا Rang وقفه متغیرهای وابسته یک تا 4 انتخاب شده است:
1 4
این جفت عدد به این معنی است که برای تمام متغیرهای وابسته در سمت راست 4 وقفه از وقفه این متغیرها نیز به عنوان رگرسور وارد میشود. هنگامی که تصریح مدل VAR مشخص شد، بر روی OK کلیک کنید تا ایویوز برآورد ماتریس ضرایب با استفاده از روش OLS انجام دهد.
[bookmark: _Toc109603198]نتیجه برآورد
برآورد مدل VAR تصریح شده به صورت خواهد بود:

[image: ]
مدل تصریح شده VAR همانطور که در بخش تکمیل پنجره VAR اشاره شد شامل سه متغیر وابسته (K=3) است (IP، M1 و TB3). همچنین مدل تصریح شده دارای یک جزء ثابت C (d=1) و تعداد 1 تا 4 وقفه برای متغیرهای وابسته است (P=4). بنابراین تعداد 13 متغیر مستقل در هر سه معادله تصریح شده وجود دارد (Kp + d=13). 
هر ستون ارائه شده در این بخش بیانگر یک تصریح معادله VAR است؛ همچنین ردیفها نیز بیانگر متغیرهای مستقل است. ایویوز برای هر متغیر مستقل، ضریب، خطای استاندارد و همچنین آماره T گزارش میکند.
ایویوز اطلاعات اضافی بیشتری در بخش پائین نتایج ضرایب را نشان میدهد. این اطلاعات به دو بخش تقسیم میشود:
· بخش اول خروجی خلاصه آمارههای برآوردی به روش OLS برای هرمعادله است.
· بخش دوم خروجی نیز خلاصه آماری سیستم VAR به عنوان یک کل است. این آمار دترمینان کوواریانس باقیماندهها، لگاریتم درستنمایی و معیارهای اطلاعاتی و تعداد ضرایب است:
[image: ]
[bookmark: _Toc109603199]نکاتی در زمینه محاسبات آمارههای سیستم:
· دو معیار اطلاعاتی  آکائیک (AIC) و شوارز (SC) بهصورت زیر محاسبه میشود:
[image: ]
در اینجا داریم:
[image: ]
که n، تعداد کل پارامترهای برآوردی در مدل VAR است.
از معیارهای اطلاعاتی میتوان بر ای مقایسه و انتخاب وقفه بهینه مدل VAR استفاده کرد که مقادیر کمتر هر معیار اطلاعاتی نسبت به مقادیر بیشتر آن ترجیح داده میشود و بیانگر قدرت پیشبینی بالاتر مدل با خطای کمتر است.
[bookmark: _Toc109603200]برآورد یک مدل بیزین[footnoteRef:3] در ایویوز [3:  Bayesian VAR] 

به منظور برآورد یک مدل بیزین مسیر:
Quick > Estimate VAR
را طی کنید و یا عبارت var را در بخش نوار فرمان تایپ و دکمه Enter را کلیک کنید تا پنجره VAR Specification باز شود.
 از بخش Var Type در سمت چپ پنجره VAR Specification، گزینه Bayesian VAR را انتخاب کنید. همانند مدلهای Var استاندارد شما در این پنجره میتوانید، لیست متغیرهای وابسته، وقفهها، متغیر مستقل را وارد کنید.  همچنین در بخش پائینی پنجره در سمت چپ میتوانید نمونه را مطابق نظر خود تغییر دهید یا آن را بدون تغییر بگذارید.
[image: ]
در پنجره اصلی Var Specification دو Tab اصلی وجود دارد؛ یکی Prior type و دیگری Prior specification است که به شما امکان سفارشی کردن تصریخ شما را میدهد.[footnoteRef:4] [4:  بحث زیر در مورد این تنظیمات فرض میکند که شما با اصول اولیه  و انواع مختلف و تنظیمات مرتبط آشنا هستید.] 

[bookmark: _Toc109603201]بخش Prior Type
بخش Prior Type برای تعیین نوع Prior  و همچنین گزینههایی برای محاسبه ماتریس کوواریانس باقیماندههای اولیه استفاده میشود.
[image: ]
در بخش نوار کرکرهای Prior Type  گزینههای مختلفی از قبیل Litterman/Minnesota، Normal-Wishart، Sims-Zha Normal-Wishart و یا Sims-Zha Normal-Flat برای انتخاب وجود دارد.
برای بقیه Priorها نسبت به گزینه Normal-Wishart، میتوانید یک روش برای برآورد ماتریس کوواریانس باقیمانده اولیه را انتخاب کنید. در صورتی که میخواهید این ماتریس کوواریانس برآورد شده با درجه آزادی مدل تعدیل شود، تیک گزینه Degrees of Freedom Vorrection فعال کنید. 
[bookmark: _Toc109603202]بخش Prior Specification
بخش Prior Specification به شما اجاره میدهد که توزیعهای اولیه را با اختصاص یک مقدار اَبَرپارامتر[footnoteRef:5] بیش از حد یا یک ماتریس اولیه ارائه شده توسط کاربر تعیین کنید. اگر شما یک اَبَرپارامتر را انتخاب کنید، باید گزینه Hyper-Parameters در کادر Type Prior Specification انتخاب کنید.  [5:  Hyper-Parameters] 

[bookmark: _Toc109603203]بخش Litterman / Minnesota Prior
با استفاده از بخش Litterman/Minnesota Prior میتوانید اَبَرپارامتر را با استفاده از  چهار اسکالر ، ،  و   محاسبه کنید. 
[image: ]
  اهمیت نسبی نمونه و اطلاعات Prior را کنترل میکند
[bookmark: _Toc109603204]مثال تجربی
برای نشان دادن شیوه برآورد بیزی و تفسیر آن فایل کاری با مشخصات زیر در نظر بگیرید. هدف تخمین یک مدل VAR(2) با استفاده از تفاضل لگاریتم سرمایهگذاری (DLINVESTMENT)، درآمد (DLINCOME) و مصرف (DLCONCUMPTION) است.[footnoteRef:6] این مجموعه دادهها توسط لاتکوپل[footnoteRef:7] (2007) برای برآورد یک مدل بیزی مورد استفاده قرار گرفته است. [6:  دادههای این مثال در سایت ایویوز با عنوان “wgmacro.WF1” قابل مشاهده است.]  [7:  Lütkepohl] 

 برای برآورد مدل بیزی ابتدا مسیر:
Quick > Estimate VAR
برای باز کردن پنجره تصریح VAR را طی کنید. در بخش VAR Type گزینه Bayesian VAR را انتخاب کنید. در بخش Endogenous Variables نیز متغیرهای وابسته را به صورت زیر وارد نمائید:
dlincome dlinvestment dlconsumption

در مرحله بعد در Tab دوم این پنجره یعنی Prior Type نوع Prior را برای مدل VAR انتخاب کنید. ایویوز به صورت پیش فرض در بخش Prior Type بر روی گزینه Litterman/Minnesota Prior  و در بخش  Initial Residual Covariance Options گزینه Univariate AR Estimate قرار دارد. شما میتوانید نوع Prior و گزینه برآورد اولیه کوواریانس را از منوها تغییر دهید. 
بخش Prior Specification تنظیمات اَبَر پارامتر را نشان میدهد. توجه داشته باشید که تنظیمات ممکن است بسته به نوع Prior متفاوت باشد. در این مثال از تنظیمات پیش فرض استفاده خواهد شد. سپس گزینه OK را کلیک کنید. 
نتایج برآورد VAR توسط ایویوز در پنجره زیر نشان داده شده است. بخش بالایی خروجی نتایج اصلی برآورد را نشان میدهد. 
[image: ]
میتوان با تغییرات در تنظیمات برآورد VAR در بخش Prior Type برآوردهای جدید را جایگزین کرد:
[image: ]
در ادامه بر روی OK کلیک کنید تا مدل بیزین VAR تعدیل شده بهصورت زیر برآورد شود. 
[image: ]

فصل اول: مدلهای خود رگرسیون برداری VAR
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[bookmark: _Toc109603205]فصل دوم: مدلهای آرچ و گارچ







[bookmark: _Toc109603206]مقدمه
اکثر ابزارهای آماری مورد استفاده در ایویوز برای مدلسازی شرایط شرطی یک متغیر تصادفی طراحی شدهاند. ابزارهایی که در این فصل توضیح داده خواهند شد، با مدل سازی واریانس شرطی یا نوسانات یک متغیر متفاوت است. دلایل متعددی برای مدلسازی و پیشبینی نوسان وجود دارد. اول ممکن است نیاز به تجزیه و تحلیل ریسک نگهداری دارایی و یا ارزش باشید. دوم، فواصل اطمینان پیشبینی ممکن است وابسته به زمان باشند، به طوری که با استفاده از مدلسازی واریانس خطاها میتوان فواصل دقیقتر را بهدست آورد. سوم، بر اگر ناهمسانی واریانس در خطاها به درستی به درستی مدلسازی شود، برآوردگرهای کارآمدتری میتوانند بهدست آید. مدلهای [footnoteRef:8]ARCH به طور خاص برای مدلسازی و پیشبینی واریانسهای شرطی طراحی شده است. واریانس متغیر وابسته به عنوان یک تابع از مقادیر گذشته متغیر وابسته و متغیرهای مستقل مدلسازی میشود. مدل های ARCH توسط انگل[footnoteRef:9] (1982) معرفی شد و بهوسیله بارلسلو[footnoteRef:10] (1986) و تیلور[footnoteRef:11] (1986)توسعه داده شد. این مدلها به طور گسترده در زمینههای مختلف اقتصادسنجی، به ویژه در تحلیلهای سری زمانی مالی استفاده میشود.  [8:  Auto Regressive Conditional Heteroskedatisticity]  [9:  Engle]  [10:  Bollerslev]  [11:  Taylor] 

در ادامه طیفی از تصریحات موجود در ایویوز که برای مدلسازی نوسانات در نظر گرفته میشود مرور میشود.
[bookmark: _Toc109603207]مدلهای GARCH 
[bookmark: _Toc109603208]مدل GARCH (1 , 1)
در ابتدا بحث خود را با سادهترین شکل GARCH شروع میکنیم:
[image: ]  (1)
[image: ] (2)
مدل میانگین ارائه شده در معادله (1) به صورت تابعی از متغیرهای مستقل و جمله خطا بیان شده است. از آنجا که  واریانس پیشبینی پیش بینی در یک دوره بر اساس اطلاعات گذشته است، واریانس شرطی[footnoteRef:12] نامیده میشود. معادله واریانس شرطی مشخص شده در معادله (2) یک تابع سه جملهای است: [12:  Conditional Variance] 

· جمله ثابت 
· اطلاعاتی درباره نوسانات دوره قبل که تحت عنوان وقفه مربع باقیماندهها در معادله میانگین اندازهگیری میشود که با  نشان داده شده است (جملات ARCH).
· واریانس پیش بینی شده دوره آخر که با  نشان داده میشود.
عبارت (1 , 1) در GARCH (1 , 1) اشاره به جملات خودرگرسیو مرتبه اول جملات GARCH دارد (اولین اصطلاح از سمت چپ در پرانتز) و جملات ARCH میانگین متحرک مرتبه اول (دومین اصطلاح از سمت چپ در پرانتز) است. یک مدل ARCH معمولی، یک حالت خاص از مشخصات GARCH است که در آن هیچ وقفه پیشبینی واریانس در معادله واریانس شرطی وجود ندارد که همان GARCH(0, 1) است.
این خصوصیات اغلب در زمینه مالی تفسیر میشود که نماینده یا معاملهگر پیشبینیکننده واریانس این دوره را با تشکیل یک میانگین وزنی از یک میانگین بلندمدت (ثابت)، واریانس پیش بینی شده از آخرین دوره (جملات GARCH) و اطلاعات در مورد نوسانات مشاهده شده در دوره قبلی (جملات ARCH) است. اگر بازده دارایی به صورت غیرمنتظره در جهت سمت بالا یا پایین حرکت کند، معاملهگر برآورد واریانس را برای دوره بعدی افزایش میدهد. این مدل همچنین با خوشهبندی نوسانات که اغلب در دادههای مالی به دست میآید، همخوانی دارد، در حالی که تغییرات بزرگ در بازده احتمالات به دنبال تغییرات بزرگتر خواهد بود. 
[bookmark: _Toc109603209]مدل GARCH (p , q)
اگر در معادله (3) داشته باشیم: 
[image: ] (3)
که در آن Xt  متغیرهای مستقل در معادله میانگین را نشان میدهند.
اگر واریانس شرطی یا انحراف استاندارد را در معادله میانگین وارد کنید، یک مل GARCH-in-Mean یا GARCH-M خواهیم داشت (انگل و همکاران، 1987). مدل ARCH-M است اغلب در برنامههای کاربردی مالی که در آن بازده مورد انتظار در یک دارایی با به ریسک انتظاری دارایی  مرتبط است، استفاده میشود. ضریب برآورد شده بر روی ریسک انتظاری، اندازه مبادله ریسک-بازگشت است.
دو نوع دیگر از مشخصات ARCH-M از انحراف استاندارد شرطی و یا ورود واریانس شرطی به جای واریانس در معادلات زیر نشان داده شده است:
[image: ](4)
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[bookmark: _Toc109603210]فرضیات توزیعی[footnoteRef:13] [13:  Distributional Assumptions] 

برای تکمیل تصریحات اولیه  ARCHنیاز به یک فرض در مورد توزیع شرطی جملات خطا است. فروضی سه گانه معمولاٌ در هنگام کار با مدلهای ARCH وجود دارد: 
· توزیع نرمال (گاوسی) 
· توزیع T-Student 
· توزیع خطای عمومی(GED) [footnoteRef:14] [14:  Generalized Error Distribution] 

با توجه به فروض توزیعی، مدل ARCH معمولاً با روش ماکزیمم درستنمایی برآورد میشود.
به عنوان مثال، برای مدل GARCH(1 ,1) با خطاهای نرمال شرطی، سهم ماکزیمم درستنمایی برای مشاهده t به صورت زیر است:
[image: ] (6)
 در یکی از فرم های بالا مشخص شده است.
برای توزیع T-Student، سهم لگاریتم درستنمایی بهصورت زیر است:
[image: ](7)
در اینجا درجه آزادی  رفتار دنباله را کنترل میکند. توزیع T-Student، زمانی که  میل میکند، به سمت توزیع نرمال نزدیک میشود. 
برای فرض سوم GED داریم:
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در اینجا پارامتر نرمال  است. توزیع خطایی عمومی (GED) داری توزیع نرمال است اگر  باشد و در صورتی که  باشد توزیع GED، دم کلفت خواهد بود
به طور پیشفرض، مدلهای ARCH در ایویوز با روش ماکزیمم درستنمایی و با این فرض که خطاها بهصورت نرمال توزیع شده باشد به صورت شرطی توزیع میشوند، برآورد میشوند.
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برای تخمین مدلهای آرچ و گارچ از مسیر زیر:
Object > New Object > Equation
گزینه ARCH را از نوار کرکرهای در انتهای پنجره باز شده به صورت زیر انتخاب نمائید در این پنجره مقدار متوسط و واریانس، توزیع خطا و نمونه برآوردی نیز ارائه شده است که باید تکمیل شود:
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بخش Mean Equation
در بخش Mean Equation باید مشخصات معادله میانگین را وارد شود. اگر مشخصه اصلی شامل یک ARCH-M باشد، باید آیتم مناسب از منوی کرکرهای را در سمت راست بالا و سمت راست پنجره باز شده انتخاب کنید. در این حالت ممکن است بسته به داده خود گزینه Std. Dev., Variance   و یا  Log(Var)را انتخاب کنید.
بخش Variance Equation
در این بخش معادله واریانس باید وارد شود.
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برای تخمین مدلهای استاندارد GARCH، گزینه GARCH/TARCH را از بخش Model انتخاب کنید. سایر گزینههای موجود در این بخش به انواع پیچیدهتر از مشخصات GARCH مربوط میشوند که در بخش برآورد ARCH توضیحات آن ارائه خاهد شد.
در بخش Order باید تعداد ARCH و GARCH را مشخص کنید. به صورت پیش فرض این مقادیر شامل 1 گارچ و 1 آرچ است که تقریباً پر استفادهترین گزینه این مورد است.
اگراگر هدف برآورد یک مدل نامتقارن باشد، باید تعداد اصطلاحات نامتقارن را در قسمت Threshold order وارد نمائید. تنظیمات پیش فرض برای بخش Threshold order در این حالت بر روی صفر قرار دارد.
بخش Variance regressors
در بخش Variance regressors فهرست متغیرهای مورد نظر شما مشخص میشود. باید توجه داشت که به استثای مدلهای GARCH، ایویوز همیشه شامل یک جزء ثابت به عنوان رگرسیون واریانس خواهد بود که شما نیازی به وارد کردن آن ندارید.
بخش Restrictions
اگر مدل GARCH / TARCH را انتخاب میکنید، میتوانید پارامترهای مدل GARCH را به دو روش محدود کنید. یکی از گزینهها این است که منوی Restrictions را به IGARCH تغییر دهید که پارامترهای پایدار را به مجموع به یک محدود میکند.گزینه دیگر Variance Target است که  یکی دیگر از گزینه Variance Target است که عملکرد پارامترهای GARCH و واریانس غیرشرطی را محدود میکند. 
بخش The Error Distribution
برای مشخص کردن فرم توزیع شرطی برای خطاها ، باید یک ورودی را از منوی Error Distribution انتخاب کنید. میتوان گزینه پیش فرض (Gaussian)، Student’ t، خطای  تعمیم یافته (GED)  و ... را وارد کنید.
بخش Estimation Options
ایویوز دسترسی شما به تعدادی از تنظیمات برآورد اختیاری را فراهم میکند. به سادگی روی گزینهها کلیک کنید و کادر محاورهای را به صورت دلخواه پر کنید. ایویوز دسترسی شما به تعدادی از تنظیمات برآورد اختیاری را فراهم میکند .به سادگی گزینههای هر Tab را کلیک کنید و پنجره باز شده را به صورت دلخواه پر کنید. 
بخش بازگشتپذیر (Backcasting) 
به طور پیشفرض، تغییراتی که در ابتدای ارزیابی MA استفاده میشود و همچنین واریانس اولیه مورد نیاز برای جملات GARCH، با استفاده از روشهای برگشتپذیری محاسبه میشوند. هنگام محاسبه واریانس اولیه برگشتپذیر برای GARCH، ایویوز ابتدا از مقادیر ضریب برای محاسبه باقیماندههای معادله میانگین استفاده میکند و سپس یک برآوردگر هموارساز نمایی از مقادیر اولیه را محاسبه میکند. 
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برای برآورد مدل استاندارد GARCH (1،1) بدون متغیر مستقل در معادلات میانگین و واریانس:
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شما باید قسمت های مختلف مشخصات خود را وارد کنید:
· بخش Mean Equation Specification را به صورت: 
R C 
پر کنید. 
· عدد 1 را برای جملات ARCH و 2 را برای تعداد جملات GARCH وارد کنید. در ادامه مسیر:
GARCH > TARCH
را کلیک کنید.
· گزینه None را برای ARCH-M term انتخاب کنید. 
· گزینه Variance Regressors را بدون تغییر بگذارید.
برای برآورد مدل ARCH(4)-M:
[image: ] (11)
برای برآورد این حالت، پنجره را به صورت زیر پر کنید: 
· معادله میانگین را وارد کنید.
· عدد 4 را برای جملات ARCH و 2 را برای تعداد جملات GARCH وارد کنید. در ادامه گزینه GARCH (symmetric) را انتخاب کنید.
· گزینه Std. Dev را برای جملات ARCH-M انتخاب کنید. 
· گزینه DUM را در بخش Variance Regressors وارد کنید.
پس از تکمیل پنجره فوق گزینه OK را کلیک کنید. مدلهای ARCH با روش ماکزیمم درستنمایی برآورد میشوند؛ بر اساس این فرض که خطاها به طور نرمال توزیع میشوند. از آنجا که واریانس به صورت غیرخطی در تابع درستنمایی ظاهر میشود، تابع احتمال با استفاده از الگوریتمهای تکرار برآورد میشود .در خط وضعیت، میتوانید مقدار احتمال را با هر تکرار تغییر دهید. 
هنگامی که برآوردها همگرا میشود، برآورد پارامترها و آمارههای مرسوم رگرسیون در پنجره   ARCH  ارائه میشود.
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به طور پیشفرض، پنجره خروجی برآورد، نمونه برآوردی و روشهای مورد استفاده برای محاسبه خطاهای استاندارد ضریب، جملات واریانس اولیه و معادله واریانس را نشان میدهد. همچنين روشي براي محاسبه واريانس پيشنمونهاي با استفاده از پارامتر  هموار شده برابر با   در نظر گرفته شده است. 
خروجی اصلی ARCH به دو بخش تقسیم میشود: بخش بالایی خروجی استاندارد برای معادله میانگین را فراهم میکند، در حالی که بخش پایین، با برچسب "Variance Equation"، شامل ضرایب، خطاهای استاندارد، Z-Statistics  و P-Values برای ضرایب معادله واریانس است. پارمترهای ARCH با  و پارمترهای GARCH با  نشان داده میشود.
پایین خروجی مجموعهای استاندارد از آمارههای رگرسیون مورد باقیماندهها در معادله میانگین را ارائه می دهد. در صورتی که هیچ متغیر مستقلی در معادله میانگین وجود نداشته باشد، در اینصورت R2 ممکن است معنیدار نباشد. در مورد فعلی R2  منفی شده است.
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در این مثال مجموع مقادیر ضرایب ARCH و GARCH () تا حد زیادی به یک نزدیک است. که مفهوم آن این است که شوک نوسانات کاملاً پایدار است. این نتیجه اغلب در داده های مالی با فرکانس بالا دیده میشود. 




اقتصادسنجی کاربردی پیشرفته با نرمافزار ایویوز

فصل دوم: مدلهای آرچ و گارچ
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برآورد پارامترها در رگرسیون کوانتایل[footnoteRef:15] براساس یک تابع زیان متقارن و نامتقارن است و مشابه برآورد پارامترها در رگرسیون حداقل مربعات محاسبه میشود. رگرسیون کوانتایل بدون داشتن محدودیات مفروضات رگرسیون معمولی، امکان دخالت متغیرهای مستقل در تمام قسمتهای توزیع به ویژه در دنبالههای ابتدایی و انتهایی را فراهم میکند و این رگرسیون زمانی که توزیع خطا غیر نرمال است و در توزیعهای با دنبالهها بلند و نامتقارن، و همچنین با وجود ناهمگنی رگرسیون با برآورد پارامترها میپردازد. این مدل توسط کونکر و باست[footnoteRef:16] (۱۹۷۸) معرفی شد و به تدریج به روش جامعی برای تجزیه تحليل أماری مدلهای خطی و غیرخطی متغیر پاسخ، در زمینههای مختلف تبدیل گردید. انگیزه اصلی به کارگیری رگرسیون چندک این است که با نگاهی دقیق و جامع در ارزیابی متغیر پاسخ، مدلی ارائه شود تا امکان دخالت متغیرهای مستقل، نه تنها در مرکز ثقل دادهها، بلکه در تمام قسمتهای توزیع به ویژه در دنبالههای ابتدایی و انتهایی فراهم گردد، بدون اینکه با محدودیت مفروضات رگرسیون معمولی، واریانس ناهمسانی و حضور تأثیرگذار دادههای دور افتاده در برآورد ضرایب پدیدار شود. در رگرسیون چندک برخلاف رگرسیون معمولی از حداقل نمودن مجموع قدر مطلق باقیماندههای موزون برای برآورد پارامتر الگو استفاده میشود که به آن روش حداقل قدر مطلق انحرافات[footnoteRef:17] (LAD) گفته میشود (کونکر و باست، 1978).  [15:  Quantile]  [16:  Koenker and Bassett]  [17:  Least Absolute Deviations] 
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برای برآورد رگرسیون کوانتایل در ایویوز میتوان از مسیر:
Object > New Object > Equation
یا
Quick > Estimate Equation
به پنجره موردنظر رسید. همچنین میتوان از طریق تایپ عبارت QREG در بخش زبان فرمان ایویوز به پنجره کوانتایل در ایویوز دسترسی پیدا کرد. 
پس از طی مسیر بالا وارد پنجره زیر خواهید شد:
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فرم پنجره رگرسیون ایویوز برای برآورد رگرسیون کوانتایل به صورت بالا خواهد بود. در ادامه دو Tab اصلی در این پنجره یعنی Specification و Option و شیوه پر کردن آن شرح داده خواهد شد.
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این Tab دارای دو بخش است.. بخش اول، که در بالا نشان داده شده است، برای مشخص کردن متغیرها در تابع Quantile Conditional،  برای برآورد و مشاهدات نمونه استفاده میشود.
همچنین شما ممکن است مایل باشید متغیرهای وابسته و رگرسورها را در بخش معادله وارد کنید. باید توجه داشته باشید که ضرایب شما باید خطی باشند.
در بخش قابل ویرایش Quantile to Eestimate شما میتوانید کوانتایل مورد نظر را وارد نمائید. ایویوز به طور پیش فرض این مقدار را 50/0 در نظر گرفته است که شما میتوانید هر مقداری بین صفر و 1 در آن وارد کنید (توجه داشته باشید که مقادیر خیلی نزدیک به صفر و 1 ممکن است باعث مشکلاتی در برآورد شما شود).
میتوانید یک تابع متوسط شرطی را برای Y تعریف کنید که با یک مقدار ثابت (C) و سری  X  اندازهگیری میشود. برآورد کنده LAD برای کل 235 مشاهده نمونه برآورد را انجام میدهد.
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بیشتر تنظیمات رگرسیون Quantile با استفاده از این پنجره بالا قابل تغییر است. گزینههای سمت چپ پنجره کنترل روش برای محاسبه کوواریانس ضرایب را ارائه میدهد که به شما اجازه میدهد که یک سری وزن برای برآورد وزنی تعیین کنید و روش محاسبه برآوردها را مشخص کنید.
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بخش Quantile Regression Options برای مشاهده به صورت زیر است:
[image: ]

در بخش Coefficient Covariance در پنجره بالا شما میتوانید روش محاسبه کوواریانس را انتخاب کنید. این روشها شامل Huber Sandwich و یا Bootstrap resampling است. به صورت پیش فرض در ایویوز روش Huber Sandwich انتخاب شده است.
 در بخش Weights شما میتوانید برای مشاهدات خود وزندهی کنید. داده ها قبل از برآورد با استفاده از این مشخصات، تبدیل میشوند. در بخش Scalar Sparsity تنظیمات دیگری برای محاسبه کوواریان وجود دارد.  برای bootstrap یا کوواریانس معمولی ممکن است گزینه Kernel و یا Siddiqui انتخاب کنید. البته در صورتی که برای محاسبه کوواریانس روش Huber Sandwich انتخاب شده باشد در بخش روش تنها گزینه Kernel فعال است.
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هنگام انتخابBootstrap  در منوی کرکرهای کوواریانس، سمت راست این پنجره برای ارائه مجموعهای از گزینههای Bootstrap تغییر میکند. در بخش Method شما میتوانید یکی از چهار  روش Bootstrap را انتخاب کنید. این چهار روش شامل Residual، XY-paiR، MCMB و        MCMB-A است که در ایویوز به صورت پیش فرض بر روی گزینه XY-pair قرار دارد. 
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در بخش پایینی این پنجره دو گزینه Replications  و  No. of obs قرار دارد. گزینه Replications   به صورت پیش فرض بر روی 100 قرار دارد که شما میتوانید به مقدار دلخواه خود تغییر دهید. گزینه  No. of obs برای تنظیمات  Bootstrapنمونه مورد استفاده قرار میگیرد. اگر این بخش خالی بماند ایویوز نمونههایی از اندازههای مشابه دادههای اصلی را رسم میکند. شواهدی وجود دارد که مشخص نمودن حجم نمونه Bootstrap کوچکتر از دادههای اولیه، ممکن است نتایج دقیقتری، به ویژه برای نمونههای بزرگ، تولید کند (کوینکر،[footnoteRef:18] 2005).  [18:  Koenker] 

 برای ذخیره نتایج Bootstrap در یک ماتریس گزینه Output را تکمیل کنید.
دو مورد آخر، تولید تعداد اعداد تصادفی را کنترل میکنند. منحنی تصادفی منقطع باید خود توضیحی باشد. از منوی کرکرهای استفاده کنید تا تولید کننده اعداد تصادفی مورد نظر خود را انتخاب کنید. ایویوز  با استفاده از تنظیمات پیش فرض برای انتخاب تولید کننده اعداد تصادفی، منوی کرکرهای را راه اندازی میکند. 
به طور پیشفرض، اگر اولین بار است که شما یک بوت استرپ را برای یک معادله داده شده انجام می دهید،  بخش  Seed خالی خواهد بود. شما ممکن است ارزش عدد صحیح خود را در صورت دلخواه ارائه کنید. اگر دانه اولیه ارائه نشده باشد،  EViews به طور تصادفی یک مقدار Seed را انتخاب می کند .مقدار این Seed اولیه با معادله ذخیره خواهد شد؛ به طوری که به طور پیش فرض برآورد بعدی از همین Seed استفاده میکند که به شما این امکان را میدهد که نتایج را دوباره تکرار کنید. اگر می خواهید از یک Seed دیگر استفاده کنید، به سادگی یک مقدار را در قسمت Seed وارد کنید یا دکمه Clear را فشار دهید تا ایویوز یک مقدار Seed تصادفی جدید بسازد.
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هنگامی که شما مشخصات رگرسیون Quantile خود را ارائه کنید و گزینههای خود را مشخص کردهاید، میتوانید بر روی دکمه OK کلیک کنید تا معادله خود را برآورد کنید .به جز حالتی که شما در حال انجام Bootstrapping با تعداد زیادی از مشاهدات هستید، نتایج برآورد باید در مدت کوتاهی نمایش داده شود.
مثال زیر یک تابع مصرف با متغیر  وابسته میانگین مصرف مواد غذایی (Y) و متغیر مستقل درآمد خانوار (X)است که شامل 235 مشاهده است. 
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قسمت بالای خروجی ویژگی دادههای برآورد شده را نمایش میدهد. در اینجا از روشHuber Sandwich برای محاسبه ماتریس کوواریانس استفاده است. همچنین در بخش Method Bandwidth گزینه Hall and Sheather  و وزن 15744/0 استفاده شده است.
در بخش پایئین نیز مقدار ضریب، عرض از مبدا، انحراف استاندارد و همچنین آماره T برای معنیدار بودن رگرسیون ارائه شده است که در مورد بالا، درآمد خانوار با توجه به مقدار آماره T مربوط به آن که 85/17 شده است و از 96/1 بیشتر است در سطح 95 درصد اطمینان اثر مثبت و معنیداری بر میانگین مصرف موارد غذایی داشته است.
در بخش پائینتر شاخصهای خوبی برازش مدل از جمله Pseudo R-Squared است.
ممکن است برای محاسبه کوواریانس به جای Bootstrapping گزینه دیگری را انتخاب کنید. ابتدا بر روی گزینه Estimate کلیک کنید تا پنجره باز شود، سپس Estimation Options را کلیک نمائید.  در ادامه MCMB-A برای محاسبه ضرایب کوواریانس انتخاب کنید. تعداد تکرارها را نیز به 500 افزایش دهید. در نهایت برای دیدن تغییرات در نتایج در نتیجه تغییرات بالا، گزینه OK را کلیک نمائید.
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اگرچه این تغییرات، سبب افزایش آماره T و همچنین کاهش انحراف استاندارد متغیر X شده است اما این اختلاف تاثیر قابل توجهی بر روی مدل نداشته است.
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بخش فضای حالت[footnoteRef:19] ایویوز یک رابط آسان برای تعیین، برآورد و کار با نتایج یک سیستم پویا که تک یا چند معادلهای هستند را فراهم میکند. ایویوز طیف گستردهای از مشخصهها، فیلتر کردن،[footnoteRef:20] هموار کردن[footnoteRef:21] و سایر ابزارهای پیشبینی را فراهم میکند که به شما در کار با سیستمهای پویا تصریح شده در فرم فضای حالت کمک میکند. طیف گستردهای از مدلهای سری زمانی، از جمله مدل رگرسیون خطی کلاسیک و مدلهای ARIMA میتواند به عنوان نمونههای خاصی از مشخصات فضای حالت نوشته شود و برآورد شود. مدلهای فضای حالت در ادبیات اقتصاد سنجی برای مدلسازی متغیرهای نامطلوب از جمله انتظارات (منطقی)، اشتباهات اندازهگیری، مشاهدات گم شده،[footnoteRef:22] درآمد دائمی، اجزای غیرقابل مشاهده (چرخه و روند) و نرخ غیر بسامدی به کار گرفته شده است. برای مطالعه جامع در زمینه مدلهای فضای حالت میتوان به فصل 14 کتاب همیلتون[footnoteRef:23] (1994) و فصول 3 و 4 کتاب هاروی (1989) مراجعه کرد. دو مزیت اصلی برای یک سیستم پویا در فرم فضای حالت وجود دارد. اول، فضای حالت اجازه میدهد که متغیرهای غیرقابل مشاهده (که به عنوان متغیرهای حالت نیز شناخته میشوند) به قابل مشاهده و در کنار آن محاسبه شوند. دوم، مدلهای فضای حالت را میتوان با استفاده از یک الگوریتم بازگشتی قوی شناخته شده به عنوان فیلتر کلمن (Bucy) تجزیه و تحلیل کرد. از جمله موارد  کاربرد دیگر الگوریتم فیلتر کالمن برای محاسبه پیشبینیهای دقیق و نمونههای محدود برای مدلهای ARMA Gaussian، مدلهای ARMA چند متغیره (بردار) و شاخصهای چندگانه و علل چندگانه (MIMIC) است.  [19:  State Space]  [20:  Filtering]  [21:  Smoothing]  [22:  Missing Observations]  [23:  Hamilton] 
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نرمافزار ایویوز انواع مختلف ابزار تخصصی را برای تعیین و بررسی مشخصات فضای حالت برای شما فراهم می کند. همانند سایر Objectهای برآورد فضای حالت، دیدگاهها و روشهای بیشتری را برای بررسی نتایج برآورد، انجام آزمونها استنتاج و تعیین مشخصات و استخراج نتایج به سایر Objectهای  ایویوز فراهم میکند. 
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ایویوز طیف گستردهای از مدلهای فضای حالت تک و چند معادله را مدیریت میکند. شما با کنترل دقیق بر مشخصات معادلات سیستم، ماتریسهای کوواریانس و شرایط اولیه  این موارد را کنترل میکنید. 
اولین گام در تعیین و برآورد یک مدل فضای حالت، ایجاد یک Object فضای حالت است. مسیر: 
Object > New Object > Sspace
را از نوار ابزار اصلی تعیین کنید. همچنین میتوانید عبارت sspace را در بخش نوار فرمان تایپ کنید.  ایویوز یک Object فضای حالت ایجاد میکند  و پنجره فضای حالت را باز میکند. دو روش برای تعیین مدل فضای حالت وجود دارد. سادهترین کار این است که از ویژگیهای "" Auto-Specification (خودکار) ایویوز استفاده کنید تا به شما در ایجاد برخی از فرمهای استاندارد برای این مدلها کمک کند. از بخش منوی فضای حالت مسیر  Proc > Define State Space را انتخاب کنید. محاورههای تخصصی باز خواهد شد  که در بخش Auto-Specification  توضیح داده خواهد شد. 
توجه داشته باشید که می توانید تصریح فضای حالت را از یک فایل متنی موجود وارد کنید. بر روی دکمه Spec کلیک کنید تا تصریحات فضای حالت نمایش داده شود، سپس کلیک راست کنید و  گزینه   Insert Text File ... را انتخاب کنید. بخش بعدی Object فضای حالت را به طور کلی توضیح میدهد.
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یک معادله حالت حاوی کلمه کلیدی "@STATE" و یک معادله حالت معتبر است. توجه داشته باشید که:
· هر معادله باید نام منحصر به فرد متغیر وابسته را داشته از آنجا که ایویوز به صورت خودکار مجموعهای از فایلهای کاری برای حالتها ایجاد نمیکند، شما میتوانید نام یک Object موجود در فایل کاری (غیر از سریها) استفاده کنید. معادلات حالت ممکن است شامل متغیرهای وابسته معادله سیگنال و  یا وقفه این متغیرها نباشد. 
· هر معادله حالت باید در وقفه یک دوره زمانیِ حالت، خطی باشد. غير خطي بودن در حالتها،[footnoteRef:24] يا وجود حالتهاي تکرار همزمان و وقفه چند دورهای زمانیِ حالت يک پيام خطا را ايجاد ميکند. [24:  States] 

· معادلات حالت ممکن است شامل متغیرهای مستقل و ضرایب ناشناخته باشند و همچنین در این عناصر غیر خطی باشد.
علاوه بر این، معادلات حالت ممکن است شامل یک خطای اختیاری یا مشخصات واریانس خطا باشد. اگر هیچ خطا یا واریانس خطایی وجود نداشته باشد، معادله حالت قطعی فرض میشود. مشخصات ساختار خطی مدل های فضایی حالت در جزئیات "Errors and Variances" شرح داده شده است.
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دو معادله حالت[footnoteRef:25] زیر، یک خطای غیرقابل مشاهده  را با یک فرایند AR(2) مشخص میکند:  [25:  Two State Equations] 

@state sv1 = c(2)*sv1(-1) + c(3)*sv2(-1) + [var = exp(c(5))]
@state sv2 = sv1(-1)

در معادله اول وقفه  AR(1) برای SV1 از نظر ضریب، C(2)  و AR(2)، از نظر ضریب C(2) است. همجنین مشخصه واریانس خطا به مربع پرانتز داده میشود. توجه داشته باشید که معادله حالت برای SV2 به صورت وقفه SV1  تعریف میشود. 
به طور مشابه، معادلات حالت زیر نیز معتبر هستند:
@state sv1 = sv1(-1) + [var = exp(c(3))]
@state sv2 = c(1) + c(2)*sv2(-1) + [var = exp(c(3))]
@state sv3 = c(1) + exp(c(3)*x/z) + c(2)*sv3(-1) + [var = exp(c(3))]
که یک گام تصادفی و یک AR(1) با رانش است.
معادلات حالت زیر معتبر نیستند:
@state exp(sv1) = sv1(-1) + [var = exp(c(3))]
@state sv2 = log(sv2(-1)) + [var = exp(c(3))]
@state sv3 = c(1) + c(2)*sv3(-2) + [var=exp(c(3))]

از آنجا معادلات حداقل یکی از شرایطی که در بالا ذکر شد (به ترتیب: عبارت متغیر حالت وابسته، غیر خطی بودن حالت، وقفه چند دورهای از متغیرهای حالت) را نقض میکنند، بنابراین معتبر نیستند.
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به طور پیش فرض، اگر تصریح معادله به طور خاص به عنوان معادله حالت با استفاده از کلمه کلیدی "STATE"  شناسایی نشود، ایویوز با آن به عنوان یک مشاهده یا معادله سیگنال رفتار خواهد کرد. معادلات سیگنال ممکن است به صراحت با کلمه کلیدی "@SIGNAL" شناسایی شود. برخی از جنبههای خاص معادله سیگنال به صورت زیر است:
· متغیرهای وابسته معادله سیگنال ممکن است شامل عباراتی باشند.
· معادلات سیگنال ممکن است حاوی مقادیر فعلی یا متغیرهای سیگنال باشد (برای مطالعه بیشتر به هاروی (1989) مراجعه کنید).
· معادلات سیگنال باید در حالتهای هم زمان، خطی باشند. غیر خطی شذن در حالتها، یک پیام خطا ایجاد میکند. 
· معادلات سیگنال ممکن است دارای متغیرهای مستقثل و ضرایب ناشناخته باشد و در این عناصر غیر خطی باشند.
معادلات سیگنال ممکن است شامل یک خطای اختیاری یا مشخصات واریانس خطا باشد. اگر خطا یا واریانس خطا وجود نداشته باشد، معادله فرض میشود که قطعی است.
[bookmark: _Toc109603231]مثالها
مثالهای زیر معتبر هستند:
log(passenger) = c(1) + c(3)*x + sv1 + c(4)*sv2
@signal y = sv1 + sv2*x1 + sv3*x2 + sv4*y(-1) + [var=exp(c(1))]
z = sv1 + sv2*x1 + sv3*x2 + c(1) + [var=exp(c(2))]

مثالهای زیر معتبر نیستند:
log(passenger) = c(1) + c(3)*x + sv1(-1)
@signal y = sv1*sv2*x1 + [var = exp(c(1))]
z = sv1 + sv2*x1 + z(1) + c(1) + [var = exp(c(2))]

از آنجا معادلات حداقل یکی از شرایطی که در بالا ذکر شد (به ترتیب: وقفه متغیر حالت، غیر خطی در متغیر حالت، ترکیب متغیر سیگنال) را نقض میکنند، بنابراین معتبر نیستند.
[bookmark: _Toc109603232]کار با نرم افزار
مدل فضای حالت ممکن است بسیار پیچیده باشند اما ایویوز با ارائه راهنماییها و تنظیمات پیشرفته تا حد زیادی این کار را برای کاربران ساده کرده است. 
برای شروع کار بر روی گزینه View و سپس گزینه Specification کلیک نمائید. نمای مشخصات زیر ارائه خواهد شد: 
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گزینه Text Screen بخشی آشنا در قسمت Specification است. 
گزینه Coefficient Description توصیف متن ساختار مشخصات فضای حالت است. متغیرهای سمت چپ به ترتیب  و  است که به عنوان توابع خطی متغیرهای حالت  بیان میشود. 

عناصر ماتریس  با ضرایب مطابقت دارند. به عنوان مثال متغیر ARMAX دارای به شرح ضرایب زیر است: 
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بخش Covariance Description توضیحات متن ماتریس کوواریانس خصوصیات فضای حالت است. به عنوان مثال ARMAX دارای تصریح کوواریانس زیر است: 
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برای کمک در ایجاد یک ویژگی فضای حالت، ایویوز ابزار "Auto-Specification" فراهم میکند که نمایش متن را که از یک مدل مشخص میکنید با استفاده از یک Dialog ایجاد میکند. این ابزار در صورتی که مدل شما یک رگرسيون استاندارد با ويژگيهای ضرايب تصادفی ثابت، بازگشتی و چندگانه باشد و يا خطاهای شما دارای ساختار کلی ARMA باشند، ممکن است بسیار مفید باشد. 
زمانی که شما مسیر: 
Proc > Define State Space
را از منو انتخاب کنید. ایویوز یک پنجره با با سه Tab را باز میکند. Tab اول برای توصیف بخش اصلی رگرسیون استفاده می شود. متغیر وابسته را وارد کنید و سپس هر رگرسوری که دارای ضریب ثابت یا بازگشتی است را وارد کنید. شما میتوانید گزینه COEF را را برای مشخص کردن ضرایب ناشناس انتخاب کنید. در پایین، شما میتوانید ساختار ARMA را برای خطاهای خود مشخص کنید. در اینجا، مشخصات یک عبارت ساده ARMA (2,1) را برای LOG(PASSENGER) مشخص شده است. 
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Tab دوم پنجره بالا، برای اضافه کردن رگرسیونهایی که دارای ضرایب تصادفی هستند استفاده میشود. رگرسیونهای مناسب را در هر یک از چهار فیلد ویرایش وارد کنید. ایویوز به کاربر اجازه میدهد تا رگرسورها را با هر ترکیبی از میانگین ثابت، AR (1)، گام تصادفی یا گام تصادفی با رانش انتخاب کنید. 
در نهایت Tab سوم پنجره Auto-Specification به شما اجازه میدهد بین ساختارهای واریانس اساسی برای مدل فضای حالت خود را انتخاب کنید. بر روی Tab  سوم با عنوان Specification Variance کلیک کنید و بین گزینههای مختلف ماتریس Identity، Common Diagona، Diagonal و یا General (Unrestricted) کلیک کنید. این Tab همچنین به شما اجازه میدهد معادله سیگنال و معادلات حالت را به صورت کوواریانس خطای غیر صفر داشته باشید. 
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مشخصات پشتیبانی شده توسط Auto-Specification بیش از حد محدود است، شما می توانید از آنها را به عنوان یک ابزار برای ساختن تصریح اصلی استفاده کنید و سپس تصریح را برای توصیف مدل خود ویرایش کنید. 
[bookmark: _Toc109603234]برآورد مدل فضای حالت
هنگامی که یک مدل فضای حالت را مشخص کنید و تایید کنید که مشخصات شما درست است، مدل آماده برآورد است. برای باز کردن پنجره برآورد، به بر روی دکمه Estimate در نوار ابزار کلیک کنید و یا Proc > Estimate را انتخاب کنید. 
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همانند سایر Objectهای برآورد، ایویوز به شما امکان میدهد که نمونه برآورد، روشهای بهینهسازی و ضریب کوواریانس، حداکثر تعداد تکرار، تحمیل همگرایی و الگوریتم برآورد را تعیین کنید. 
روش بهینهسازی پیش فرض برای Objectدر بخشsspace،  BFGS است، اما شما ممکن است گزینههای Newton-Raphson و یا OPG–BHHH را انتخاب کنید. برای برآورد غیرمنطقی،[footnoteRef:26] روش مرحلهای به شما اجازه می دهد بین روش پیش فرض، Dogleg و Line یکی را انتخاب کنید.  [26:  Non-Legacy Estimation] 

 پیش فرض Ordinary بر روی Covariance Method، معکوس واریانس در منوی کرکرهای Information Matrix  است. اگر شما بهینهسازی را غیرمنطقی انجام دهید، میتوانید از Hessian مشاهده شده با انتخاب Hessian - Observed استفاده کنید. تنظیمات پیش فرض باید شروع خوبی برای مواجه با اکثر مشکلات باشد، در غیر اینصورت تنظیمات را تغییر دهید.
[bookmark: _Toc109603235]نکته مهم
دو مورد اساسی در هنگام برآورد مدل وجود دارد:
· اگرچه روش فیلتر کالمن در ایویوز به طور خودکار تمام مقادیر گمشده در نمونه را اداره میکند، اما ایویوز نیازمند آن است که نمونه برآورد شما دارای یک پیوستگی باشد و شکافی بین مشاهدات وجود نداشته باشد. 
· اگر در تصریح هیچ ضرایب ناشناسی وجود نداشته باشد، هنوز باید برآورد sspace خود را برای اجرای فیلتر کالمن انجام دهید.
زمانی که شما گزینه OK را کلیک کنید، پنجره برآورد ارائه خواهد شد: 
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برخی از بخشهای خروجی، جدید هستند و ممکن است نیاز به بحث داشته باشند. بخش پایین اطلاعات اضافی در مورد مقادیر گم شده را در برآورد فراهم می کند. مشاهدات احتمالی گزارش تعداد واقعی مشاهدات که در شکلگیری احتمال استفاده میشود را نشان میدهد. این عدد (که در محاسبه معیارهای اطلاعات مورد استفاده قرار می گیرد) از «Included Observations» که در بالای صفحه نمایش داده می شود، متفاوت است، گاهی ایویوز یکی از مشاهدات را از محاسبه احتمالی، خارج میکند؛ زیرا تمام معادلات سیگنال دارای مقادیر گمشده هستند. تعداد مشاهدات حذف شده در "Missing Observations" گزارش شده است. "Partial Observations" تعداد مشاهداتی را که احتمالاً شامل می شوند را اما برای برخی معادلات حذف شده است را نشان میدهد و "Diffuse Priors" نشان دهنده تعداد کواواریانس های اولیهای است که ایویوز قادر به حل آن نیست و برای آن نیازی به مقداردهی اولیه کاربر نیست را نشان میدهد. 
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[bookmark: _Toc109603238]مقدمه
روش رایج برای مطالعهی رفتار پویای اقتصادی و مالی استفاده از مدلهای سری زمانی است. این مدلها یا به صورت مدلهای خطی از جمله مدلهای خود رگرسیونی() و یا میانگین متحرک () و یا مدلهای غیر خطی مارکوف-سوئیچینگ () مورد بررسی قرار میگیرند. مدل مارکوف-سوئیچینگ برای اولین بار توسط کوانت (1972)، کوانت و گلدفلد و کوانت[footnoteRef:27] (1973) معرفی شد و توسط همیلتون[footnoteRef:28] در سال 1989 مطرح و توسعه داده شد و به مدل تغییر رژیم شناخته میشود. در مدل غیر خطی فرض این است که رفتار متغیری که قرار است مدلسازی روی آن صورت گیرد در وضعیتهای مختلف تغییر میکند. مدل مارکوف بر اساس مدل چرخه کسب و کار همیلتون، که چرخه را به عنوان فرایند دو حالت با تغییرات رژیم تصادفی مشخص کرد، گرفته شده است. دلیل استفاده از واژه تغییر رژیم به این دلیل است که فقط متغیر سیاستی ممکن است در دورهای از زمان معین دارای یک رفتار و فرآیند باشد و در دورهای دیگر رفتار دیگری از خودش نشان دهد. [27:  Goldfeld and Quandt]  [28:  Hamilton] 

این فصل در ارتباط با معرفی و کاربردهای منوی سوئیچینگ در نرمافزار ایویوز 10 است. در بخش کار با نرمافزار، منوها و قابلیتها و کاربرد هر یک از این منوها در برآورد روش سوئیچینگ شرح داده خواهد شد. در پایان نیز منابعی پیشنهای برای مطالعه بیشتر ارائه شده است.
[bookmark: _Toc109603239]کار با نرمافزار
برای رسیدن به پنجره سوئیچینگ ابتدا مسیر زیر را از منوی طی کنید:
Quick > Estimate Equation
سپس مطابق شکل زیر گزینه Switching Regression را در نوار کرکرهای Method انتخاب کنید:
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پنجره باز شده دو زبانه وجود دارد. اولی برای مشخصه اصلی رگرسیون سوئیچینگ استفاده میشود و دومی شامل گزینههایی برای تغییر ویژگیهای انتخاب شده برای کنترل جنبههای محاسباتی برآورد است. صفحه Specification شامل سه بخش است مشخصات معادله، مشخصات سوئیچینگ و تنظیمات برآورد است که در اینجا تمرکز بر دو بخش اول است:
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در بخش اول باید متغیر وابسته (که در اینجا (Yt)) ابتدا و به دنبال آن متغیرهای مستقل وارد میشود (در اینجا (Xt)). رگرسیونهایی که ضرایب غیر متغیر دارند (در اینجا (Zt) باید در فیلد دوم ذکر شوند.
میتوان گزینه خطای خاص رژیم واریانس (Regime Sspecific Error Variances) در صورتی که مایل به بررسی ناهمسانی واریانس[footnoteRef:29] در رژیم سوئیچینگ باشید تیک بزنید. [29:  Heteroskedasticity] 

گاهی ممکن است که شما مایل باشید از یک رگرسیون پویا با اضافه کردن وقفههای متغیر وابسته به عنوان متغیر مستقل شامل جزء AR برای بررسی خودهمبستگی باشید.
[bookmark: _Toc109603240]بخش Switching Specification
پنجره بخش Switching Specification به صورت زیر است:
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بخش Switching Specification مشخصات رژیم را کنترل میکند.
نوار کرکرهای Switching Type به شما اجازه می دهد بین سوئیچ ساده و مارکوف انتخاب کنید. تنظیم پیش فرض نرمافزار ایویوز  بر روی یک مدل سوئیچینگ ساده است
شما باید تعداد رژیمها را در قسمت Number of Regimes وارد کنید. پیش فرض نرمافزار بر روی دو رژیم قرار دارد. باید درنظر داشت برآورد مدلهای سوئیچینگ با بیش از چند رژیم ممکن است  دشوار باشد.
ممکن است مایل باشید که رگرسیونهای اضافی را برای احتمالات غیر شرطی[footnoteRef:30] رژیم ریسک غیر شرطی (برای سوئیچینگ ساده) یا ماتریس احتمال انتقال رژیم (برای مارکوف سوئیچینگ) را تعیین کنید. نکته مهم   در این بخش این است که دادههایی برای رگرسیونهای احتمالی در دوره t که احتمال انتقال یا رژیم برای دوره t تعیین میکنید باید در دوره زمانی Work File فایل قرار گیرد.  [30:  Unconditional Regime Probabilities] 

[bookmark: _Toc109603241]بخش Option
با کلیک بر روی option از پنجره Equation Estimation گزینههایی برای تغییر ویژگیها، مشخصات، تغییر و کنترل جنبههای مختلف محاسبات به صورت زیر نمایش داده میشود.
[bookmark: _Toc109603242]بخش Switching
بخش Switching مطابق شکل زیر ممکن است برای تعیین احتمالات اولیه  و یا هرگونه محدودیتی برای بردار احتمالی رژیم یا ماتریس انتقال استفاده شود.
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ارزیابی احتمال در مارکوف سوئیچینگ و مدل SSAR نیاز به مقادیر پیش فرض برای احتمالهای فیلتر شده ("احتمال اولیه") دارد. ردیف احتمالات اولیه رژیم به شما امکان میدهد تا روش اولیه تعیین این مقادیر را انتخاب کنید. اگر گزینه User-Specified را انتخاب کنید،  ایویوز به شما این امکان را میدهد که خودتان احتمالات اولیه ؤزیم را وارد نمائید.
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ایویوز  پارامترهای احتمال را با استفاده از روش  Broyden، Fletcher، Goldfarb  و Shanno (BFGS)  برآورد میکند. به طور پیش فرض، کوواریانس ضرایب با استفاده از d.f. که معکوس هشین تصحیح شده از مشاهدات منفی[footnoteRef:31] است محاسبه میشود. [31:  Corrected Inverse of the Negative of the Observed Hessian] 

همچنین شما می توانید از منوی کرکرهای Method Covariance به ایویوز به منظور استفاده از هشین دستور دهید.، محصول بیرونی روش شیب (OPG) یا کوواریانس قوی هوبر سفید استفاده کنید که ساندویچ را با استفاده از Hessian و شیب ها تشکیل می دهد. گزینه Adjustment checkbox d.f برای حذف تصحیح d.f استفاده میشود. 
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بخش  Iteration Control شامل زمینههای استاندارد برای تنظیم حداکثر تعداد تکرار و تحمیل همگرایی است. به طور پیش فرض، ایویوز از تنظیمات برآورد خود از گزینههای عمومی استفاده میکند. شما میتوانید گزینه Display settings را برای نمایش مقادیر شروع و سایر تنظیمات برآورد در بخش بالا برای خروجی برآورد شده خود انتخاب کنید.
شما می توانید بخش Starting values را برای کنترل تنظیم برآوردهای اولیه پارامترها استفاده کنید. مدلهای رگرسیون سوئیچینگ اغلب ریشههای محلی دارند و ممکن است برای برآورد آنها دشوار باشد بنابراین ایویوز ابزارهای گوناگونی برای انتخاب مقادیر اولیه ارائه میدهد.
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بخش Start Method  به شما اجازه می دهد یک روش اساسی  که شامل:
EViews Supplied
0.80 x EViews Supplied, 
0.5 x EViews Supplied
0.3 x EViews Supplied
Zero, User-Supplied

است را برای Starting Value انتخاب کنید. 
روشهای ارائه شده در ایویوز از برآورد ضرایب حداقل مربعات ساده (OLS) یا بخش مشخصی از این برآوردها استفاده میکنند. ضرایب AR به طور دلخواه به صفر تنظیم می شوند.
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دو فیلد اولیه در بخش Randomized Estimates به شما این امکان را میدهد که مقادیری تصادفی را بر اساس روشهای ارائه شده در بخش Start method را انتخاب کنید. همچنین ایویوز به صورت تصادفی تعداد تکرارها را در بخش Iterations مشخص میکند. ضرایب با بالاترین مقدار احتمال به عنوان مقادیر اولیه انتخاب میشوند.
برای مقادیر پیش فرض (یعنی مواردی که توسط کاربر تعیین نمیشود)، ایویوز، به طور پیش فرض، 25 مجموعه مقادیر شروع تصادفی تولید میکند و قبل از انتخاب بهترین مجموعه به عنوان مقادیر شروع، هر 10 تکرار را اصلاح میکند. به طور پیش فرض، تصادفی بودن مقادیر ارائه شده در حالت  user-supplied وجود ندارد. همچنین علاوه بر مقادیر اولیه، میتوانید بر اساس ضرایب برآورد نهایی نیز تصادفی کنید. 
مقادیر شروع تصادفی با انتخاب بهترین مقادیر برآورد شده در دوره مورد بررسی و اضافه کردن مقادیر Random Scale داده شده توسط انحراف استاندارد ضرایب نهایی انتخاب میشود. برآوردها با بیشترین احتمال به برآوردهای نهایی تبدیل میشوند. ایویوز به طور پیش فرض این مورد را انجام نمیدهد و باید توسط کاربر انجام بگیرد.
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شما میتوانید از نوار کرکرهای در منوی ایویوز گزینه Optimization Method برای روشهای مختلف مطابق شکل زیر انتخاب کنید:
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شما میتوانید از روش BFGS برای برآورد پارامترها استفاده کنید. همجنین شما میتوانید از روشهای BFGS، OPG – BHHH و یا Newton-Raphson در نوار کرکرهای Optimization Method استفاده کنید. 
در همین بخش گزینه Step Method  به شما امکان میدهد که گزینههای Marquardt ، Dogleg  و یا Line Search را انتخاب کنید. 
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سیستم[footnoteRef:32] شامل یک گروه معادلات حاوی پارامترهای ناشناخته است. سیستم ها را میتوان با استفاده از تعدادی از روشهای چند متغیره برآورد کرد که وابستگی متقابل بین معادلات در سیستم را در نظر بگیرند.  [32:  System] 

شکل عمومی یک سیستم به صورت زیر است: 

در اینجا  برداری از متغیرهای وابسته و  نیز برداری از متغیرهای مستقل است. همچنین  نیز جملات اخلال در هر معادله است.  نیز ضرایب پارامترهای معادلات را نشان میدهد.
ایویوز تعدادی از روشهای برآورد پارامترهای سیستم را ارائه میدهد. رویکرد اول برآورد جداگانه هر معادله سیستم است .رویکرد دوم این است که پارامترهای معادلات به طور همزمان مجموعه و کامل برآورد شود. رویکرد همزمان به شما اجازه میدهد محدودیتهایی بر روی ضرایب در معادلات قرار دهید و از روشهایی مطابق با همبستگی در بین اجزای اخلال استفاده کنید. این روشها به واسطه اینکه همبستگی بین اجزاء خطای معادلات مختلف را لحاظ میکنند توان این را دارند که کارای مجانبی باشند؛ یعنی دو خاصیت سازگاری و کارایی را به طور همزمان دارا هستند. همچنین شما می توانید پارامترهای یک سیستم معادلات را برآورد کنید و سپس یک مدل برای پیشبینی یا شبیهسازی ارزشهای متغیرهای درونزا در سیستم ایجاد کنید.
در حالی که مزایای مهمی برای استفاده از یک سیستم برای ارزیابی پارامترها وجود دارد، اما آنها بدون هزینه نیستند. مهمتر از همه، اگر شما از یکی از معادلات موجود در سیستم را استفاده نکنید و پارامترهای خود را باید با استفاده از روشهای تک معادله برآورد کنید که برآوردی ضعیف خواهد بود. حتی اگر از روش سیستمی استفاده کنید بازهم ممکن است ضعیف بودن برآورد یکی از معادلات میتواند به بقیه معادلات نیز سرایت کند. یکی از فروص کلاسیک و بسیار مهم، مستقل بودن متغیرهای توضیحی از جزء اخلال است. در سیستمهای معادلات همزمان، این فرض نقض میشود و  ممکن است برخی از متغیرهای توضیحی، تابعی از جزء اخلال هستند. در واقع، با فرض داشتن یک سیستم دو معادلهای، علاوه بر متغیر وابسته معادلهی اول، متغیر وابسته معادلهی دوم نیز تابعی از جزء خطای معادلهی اول میباشد. این همبستگی جزء اخلال با متغیرهای توضیحی در اقتصادسنجی به مساله همزمانی[footnoteRef:33] معروف است. [33:  Simultaneous Problem ] 

[bookmark: _Toc109603251]روشهای معادلات همزمان[footnoteRef:34] [34:  System Estimation Methods] 

ایویوز پارامترهای یک سیستم معادلات را با استفاده از روشهای زیر برآورد میکند: 
1. حداقل مربعات معمولی[footnoteRef:35] (OLS) [35:  Ordinary Least Squares] 

2. معادلات رگرسیون وزنی[footnoteRef:36] [36:  Equation Weighted Regression] 

3. رگرسیونهای به ظاهر غیرمرتبط[footnoteRef:37]  (SUR)  [37:  Seemingly Unrelated Regression] 

4. حداقل مربعات دو مرحلهای[footnoteRef:38]  (2SLS) [38:  System Two-State Least Squares] 

5. حداقل مربعات دو مرحلهای وزن[footnoteRef:39] [39:  Weighted Two-Stage Least Squares ] 

6. حداقل مربعات سه مرحلهای[footnoteRef:40] (3SLS) [40:  Three-Stage Least Square ] 

7. روش گشتاورهای تعمیم یافته (GMM) [footnoteRef:41]  [41:  Generalized Method of Moment] 

8. واریانس ناهمسانی شرطی اتورگرسیو[footnoteRef:42] (ARCH) [42:  Autoregressive Conditional Heteroskedasticity] 

[bookmark: _Toc109603252]حداقل مربعات معمولی (OLS)
این روش مقدار مجموع مربعات باقیماندهها را برای هر معادله را حداقل میکند به طوری که برای هر یک از پارامترهای سیستم محدودیتی اعمال میشود. اگر چنین محدودیتی وجود نداشته باشد، این روش با تخمین از هر معادله با استفاده از حداقل مربعات معمولی (OLS) یکسان است.
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این روش توضیحی برای ناهمسانی واریانس بین معادلات متقابل با حداقل کردن مجموع مجذور باقیمادههای معادلات وزنی است. وزن معادله، معکوس واریانس معادلات برآورد شده است و از برآورد پارامترهای غیر وزنی سیستم حاصل میشود. این روش در صورتی که محدودیتی بر روی معادلات متقابل وجود نداشته باشد با نتایج روش OLS تک معادلهای برابر است.
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روش رگرسیونهای به ظاهر نامرتبط (SUR)، همچنین به طور غیر رسمی به عنوان رگرسیون چند متغیره یا زلنر[footnoteRef:43] نیز شناخته می شود، یپارامترهای سیستم را را براساس ناهمسانی واریانس و همبستگی پیاپی بین اجزای اخلال  برآورد میکند. همچنین برآوردهای ماتریس کوواریانس معادلات سیستم بدون وزن است. ایویوز یک فرم کلیتر SUR را پیشبینی میکند؛ این امر اجازه میدهد تا محدودیتهای معادله بر روی پارامترها نیز وجود داشته باشد. [43:  Zellner] 
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روش حداقل مربعات دو مرحلهای (2SLS) یک نسخه سیستمی از رگرسیون تک معادلهای 2SLS است. این روش مناسب زمانی است که برخی از متغیرهای سمت راست معادله با عبارات خطا مرتبط هستند اماهیچ همبستگی پیاپی و ناهمسانی واریانس در جملات اخلال وجود ندارد. ایویوز حداقل مربعات دو مرحلهای (2SLS) را با استفاده از معادله TSLS بدون وزن، و محدودیتهای وضع شده بر روی معادلات برآورد میکند. اگر هیچ محدودیت معادلهای وجود نداشته باشد، نتایج حداقل مربعات دو مرحلهای سیستمی (2SLS) معادل با  2sls تک معادلهای بدون خواهد بود. . روش حداقل مربعات دو مرحلهای (2SLS) از روشهایی است که از تمام متغیرهای از پیش تعیین شده به عنوان متغیر ابزاری برای رسیدن به برآوردهای کارا و سازگار استفاده میکند. این روش اگرچه به ویژه برای معادلات بیش از حد مشخص به وجود آمده است، اما آن را میتوان برای حل معادلات دقیقاً مشخص نیز به کار برد.
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برآورد کننده سیستمی واریانس ناهمسانی شرطی اتورگرسیو (ARCH) نسخه چند متغیره برآوردکننده ARCH است. سیستم ARCH روشی مناسب برای زمانی که فرد میخواهد مدل واریانس و کوواریانس جملات خطا را، به طور کلی در فرم اتورگرسیو وارد کند مناسب است.
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برای برآورد پارامترهای سیستم معادلات، ابتدا باید یک Object سیستم ایجاد کنید و سیستم معادلات را مشخص کنید. سه راه برای ایجاد یک سیستم وجود دارد: بهصورت دستی و با وارد کردن یک تصریح با قرار دادن یک فایل متنی حاوی تصریح، یا با اجازه دادن به ایویوز برای ایجاد یک سیستم به صورت خودکار از طریق لیست انتخاب شده متغیرها ایجاد میکند.
برای ایجاد یک سیستم جدید به صورت دستی یا با قرار دادن یک فایل متنی  ابتدا مسیر زیر را طی کنید یا عبارت "System"  را در بخش فرمان ایویوز تایپ و Enter را کلیک کنید:
Object > New Object > System
با طی مسیر بالا پنجره خالی سیستم باز میشود. در این بخش باید مشخصات سیستم را را با پرکردن مناسب گزینهها تکمیل کنید. برای برآورد پارامترهای سیستم معادلات شما ابتدا باید یک Object سیستم ایجاد کنید و سیستم معادلات را مشخص کنید. 
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ایویوز همچنین میتواند از لیست متغیرهای انتخاب شده، به صورت خودکار معادلات خطی را در یک سیستم تولید کند. برای استفاده از این روش ابتدا متغیرهای وابسته را که در سیستم وجود دارد را برجسته (هایلاید) کنید.
در مرحله بعد بر روی متغیرهای هایلاید شده دوبار کلیک کنید و مسیر Open > Open System را طی کنید و یا کلیک راست کنید و گزینه Open > as System را انتخاب کنید. در این حالت باید پنجره Make System با اسم متغیرهای وارد شده در بخش Dependent variables باز شود. شما میتوانید رگرسیون را را با اضافه کردن جملات AR، یا تخمین زده شده و یا ضرایب خاص معادله گسترش دهید.
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معادلات خود را با استفاده از عبارات استاندارد ایویوز وارد کنید. معادلات در سیستم شما باید معادلات رفتاری با ضرایب ناشناخته و یک جمله خطای ضمنی باشد.
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تصریح یک سیستم دو معادلهای ساده را در نظر بگیرید. شما میتوانید ضرایب پیش فرض ایویوز    C(1), C(2) , … را استفاده کنید. البته شما میتوانید از ضرایب بردارهای دیگر با کلیک کردن بر روی مسیر:
Object > New Object > Matrix-Vector-Coef  > Coefficient Vector
در منوی اصلی ایویوز استفاده نمائید. 
برخی از مهمترین قوانین عمومی برای تعریف معادلات وجود دارد که شامل: 
· معادلات میتوانند نسبت به متغیرها، ضرایب یا هردو غیرخطی باشند. محدودیتهای اعمال شده در معادلات ممکن است با استفاده از ضرایب مشابه در معادلات مختلف اعمال شود. به عنوان مثال:
y = c(1) + c(2)*x
z = c(3) + c(2)*z + (1-c(2))*x

· شما همچنین ممکن است محدودیتهای اضافهای را اعمال کنید. معادله زیر را در نظر بگیرید:
y = c(1)*x1 + c(2)*x2 + c(3)*x3

شما ممکن است مایل به تحمیل محدودیتی به صورت C(1)+C(2)+C(3)=1 باشید. شما میتوانید این محدودیت معادله را به صورت زیر تغییر میدهد:
y = c(1)*x1 + c(2)*x2 + (1-c(1)-c(2))*x3

· معادلات ممکن است شامل مشخصه خطای اتورگرسیو (AR) باشد اما مشخصههای MA، SAR و SMA نباشد. در این مورد شما باید ضرایب را به هر جمله AR ارتباط دهید. مشخصهای AR را در یک پرانتز قرار دهیدو برای مرتبط کردن AR به ضرایب همانند زیر از علائم مساوی (“=”) استفاده کنید:
cs = c(1) + c(2)*gdp + [ar(1)=c(3), ar(2)=c(4)]
شما میتوانید تمام معادلات را در یک سیستم محدود کنید تا ضرایب AR مشابه را با دادن تمام معادلات مشابه نیز به اندازه همان مقدار ضریب AR داده شود. همچنین میتوانید پردازشهای جداگانه AR را با تعیین هر معادله ضریب خود محدود کنید.
· معادلات در یک سیستم نیازی به یک متغیر وابسته ندارند که علامت مساوی (=) را دنبال کند. علامت "=" میتواند در هر جای فرمول باشد:
log(unemp/(1-unemp)) = c(1) + c(2)*dmr

شما همچنین میتوانید معادله را با یک بیان ساده و بدون نیاز به متغیر وابسته مانند مثال زیر بنویسید:
(c(1)*x + c(2)*y + 4)^2

هنگام مواجه شدن با یک عبارت که یک علامت مساوی (=) ندارد، ایویوز تمام عبارت را برابر با جملات خطای ضمنی[footnoteRef:44] قرار میدهد. [44:  Implicit Error Term] 
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اگر شما از روش 2SLS، 3SLS و یا GMM استفاده میکنید، باید متغیرهای ابزاری مورد استفاده را تعیین کنید. روشهای مختلفی برای مشخص کردن ابزارهای موردنیاز وجود دارد که با فرم مناسب بسته به اینکه آیا میخواهید ابزارهای یکسان در هر معادله داشته باشید و یا اینکه آیا میخواهید پیشبینیها را بر اساس معادله محاسبه کنید.
در سادهترین مورد ممکن (حالت پیش فرض)، ایویوز پیشبینیهای متغیر ابزاری خود را بر اساس معادله به معادله تشکیل میدهند. اگر ترجیح میدهید به این فرایند به عنوان یک روش دو مرحلهای (2SLS) نگاه کنید، رگرسیون اول متغیرها در مدل شما بر روی ابزارها به طور جداگانه برای هر معادله اجرا میشود. 
در این تنظیمات دو روز برای برای مشخص کردن ابزارها وجود دارد. اگر مایل به استفاده از متغیرهای ابزاری یکسان در معادلات هستید، باید یک خط معادله با کلمات کلیدی @INST و یا INST و لیستی از متغیرهای مستقل در ادامه آن که قرار است به عنوان ابزار استفاده شوند، را وارد کنید. برای مثال خط:
@inst gdp(-1 to -4) x gov
دستور ایویوز را برای استفاده از شش متغیر به عنوان ابزار برای تمام معادلات در سیستم هدایت میکند. برآورد سیستم شامل یک طرح مجزا برای هر معادله در سیستم معادلات شما خواهد بود.
شما همچنین ممکن است ابزارهای مختلفی برای هر معادله را با اضافه کردن علامت "@" در انتهای معادله مشخص کنید و سپس یک لیست از ابزار برای این معادله را مشخص کنید. به عنوان مثال:
cs = c(1)+c(2)*gdp+c(3)*cs(-1) @ cs(-1) inv(-1) gov
inv = c(4)+c(5)*gdp+c(6)*gov @ gdp(-1) gov
معادله اول از cs(-1), inv(-1) gov و یک جزء ثابت (عرض از مبداء) به عنوان متغیر ابزاری استفاده میکند. اما در معادله دوم gdp(-1) و   govو یک جزء ثابت را به عنوان متغیر ابزاری در نظر میگیرد.
در نهایت شما میتوانید این دو روش را ترکیب کنید. هر معادله بدون ابزارهای مشخصه انفرادی از ابزارهای مشخص شده توسط عبارت "@inst" را مشخص میشود. به عنوان مثال در سیستم زیر: 

@inst gdp(-1 to -4) x gov
cs = c(1)+c(2)*gdp+c(3)*cs(-1) 
inv = c(4)+c(5)*gdp+c(6)*gov @ gdp(-1) gov

معادله CS از متغیرهای GDP(-1), GDP(-2), GDP(-3), GDP(-4), X, GOV, و جز ثابت و در معادله INV از gdp(-1) و   govبه عنوان متغیر ابزاری استفاده میکند. 
[bookmark: _Toc109603260]چند نکته
· در زمینه روشهای مورد استفاده، در صورتی که تعداد متغیرهای ابزاری از تعداد مشاهدات بیشتر است، پیشنهاد میشود که روش 2SLS قابل قبولترین روش برآورد است.
· برای معین کردن ابزارها برای طرحبندی پروژهها، از عبارت @stackinst استفاده میشود. البته این عبارت تنها برای روش 2SLS و 3SLS در دسترس است و برای روش GMM در دسترس نیست.
· در صورتی که عبارت C جزء متغیرهای ابزاری باشد، این شامل معادلات انفرادی نمیشود. در صورتی که C در بین متغیرهای ابزاری نباشد در آن صورت به عنوان یک ابزار در هر معادله گنجانده میشود؛ اگرچه به صراحت این موضوع بیان شده باشد.
· شما باید تمام متغیرهای مستقل سمت راست را به عنوان ابزار برای معادله داده شده فهرست کنید.
· شناسایی[footnoteRef:45] مستلزم آن است که در هر معادله باید حداقل تعداد زیادی از ابزار (شامل جزء ثابت) وجود داشته باشد، زیرا متغیرهای سمت راست (متغیرهای مستقل) در آن معادله وجود دارد.[footnoteRef:46] [45:  Identification]  [46:  در سرتاسر این کتاب منظور از متغیرهای سمت راست، متغیرهای مستقل و منظور از متغیرهای سمت چپ نیز متغیرهای وابسته است.] 

· بیان stackinst@ تنها برای 2SLS و 3SLS در دسترس است و برای GMM در دسترس نیست.
· اگر شما سیستم خود را با استفاده از یک روش که از ابزار استفاده نمیکنید برآورد کنید، تمامی خطوط مشخصه ابزار نادیده گرفته میشوند.
حال با توضیحات بالا شیوه برآورد یک سیستم توضیح داده خواهد شد.
[bookmark: _Toc109603261]برآورد یک سیستم با نرمافزار ایویوز
زمانی که سیستم خود را ایجاد و مشخص کردید، میتوانید دکمه Estimate را روی نوار ابزار فشار دهید تا پنجره Discovery Estimation باز شود.
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منوی کرکرهای Estimation Method به شما چند گزینه برای روش برآورد ارائه میدهد. شما میتوانید از یکی از چند روش برای برآورد پارامترهای مشخص شده خود انتخاب کنید.
پنجره برآورد ممکن است نسبت به انتخاب شما تغییر و گزینههای دیگری را ارائه دهد. اگر برآوردگر انتخاب شده از متغیرهای ابزاری استفاده میکند، کادری ظاهر خواهد شد که شما را باید برای رفع  انتخاب کنید باید فرایند AR و یا وقفه رگرسورها را وارد کنید.
[bookmark: _Toc109603262]تنظیمات GMM
اگر شما گزینه GMM-Cross Section را انتخاب نمائید، گزینهای بیشتری به شما ارائه میشود. توجه داشته باشید که روش GMM  دراین حالت از یک رگرسیون مقاوم شده نسبت به ناهمسانی واریانس و همبستگی پیاپی که شکل آن ناشناخته است استفاده میکند. در حالی که در روش GMM-Time Series (HAC) این رگرسیون مقاوم شده را به فرم ناشناخته خودهمبستگی گسترش میدهد.
اگر شما روش GMM را انتخاب کنید ایویوز گزینه Identity Weighting Matrix in Estimation را نشان میدهد. ضرایب برآوردی و مشخصههای GMM برای محاسبه یک ماتریس کوواریانس که مقاطع نسبت به ناهمسانی واریانس و خودهمبستگی مقاوم شده است. اگر این گزینه انتخاب نشده باشد ایویوز از وزنهای GMM هم در برآورد و هم در محاسبه کوواریانس ضرایب استفاده خواهد کرد.
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وقتی شما گزینه GMM-Time Series (HAC) را انتخاب کنید، پنجره ایویوز گزینههای اضافی برای تعیین وزن ماتریس را نشان میدهد. گزینههای جدید در سمت راست پجره ظاهر میشود. این گزینهها ناهمسانی واریانس و خودهمبستگی مقاوم شده ماتریس وزنی را کنترل میکند.
گزینه Kernel فرم تتابعی Kernel مورد استفاده برای وزندهی اتوکوواریانس برای محاسبه ماتریس وزنی را ارائه میدهد. گزینه Bandwidth Selection تعیین کننده چگونگی وزن داده شده توسط تغییر Kernel با وقفه اتوکوواریانس در محاسبه اوزان ماتریس است. اگر دز این بخش Fixed را انتخاب نمائید، شما میتوانید تعداد Bandwidth و یا عبارت"NW" را برای استفاده از Newey  و  West’s معیار انتخاب Bandwidth را تعیین کنید. 
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اگر روش ARCH - Conditional Heteroskedasticity انتخاب شود، پنجره موردنظر برای مدلهای ARCH ظاهر  میشود.
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 Model Type به شما اجازه میدهد تا از بین سه مدل ARCH چند متغیره مختلف Diagonal VECH, Constant Conditional Correlation (CCC) و Diagonal BEKK یک گزینه را انتخاب نمائید. 
گزینه Auto-regressive order تعداد جملات خودرگرسیو مدل را نشان میدهد. همچنین ممکن است از گزینه Variance Regressors برای تعیین رگرسورهای موجود در معادله واریانس استفاده کنید. مشخصات ضرایب برای جملات خودرگرسیو و رگرسورها در معادله واریانس ممکن است با استفاده از گزینه ARCH Coefficient Restrictions  کنترل شود.
هر جمله خودرگرسیو یا رگرسورها در لیست ضرایب نمایش داده میشود. شما باید یک جمله را برای اصلاح آن انتخاب کنید و در قسمت Restriction  یک مشخصه نوع ضریب را برای اصطلاح آن انتخاب کنید. برای مدل VECH ، هر یک از ماتریس ضرایب ممکن است به Scalar, Diagonal, Rank One, Full Rank, Indefinite Matrix و یا Variance Target محدود شود. به طور پیش فرض توزیع جملات اخلال نرمال فرض میشود. شما باید آن را در نوار کرکرهای به جای Multivariate Student's گزینه Error Distribution انتخاب کنید. 
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برای سیستمهای برآورد شده با استفاده از روش FIML، از شما خواسته میشود تنظیمات برآورد برای باقیماندههای ماتریس کوواریانس را مشخص کنید. 
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بخش Residual Covariance به شما اجازه میدهد از بین Unrestricted, Diagonal, User-covariance و User-factor یکی را انتخاب کنید. 
· بخش Unrestricted Setting ارزیابی استانداردی ازبرآوردگر FIML است که در آن تمام عناصر باقیماندههای ماتریس کوواریانس همراه با ضرایب معادله میانگین محاسبه میشود.
· تنظیمات Diagonal 
توجه داشته باشید که Objectهای سیستم برآورد شده با استفاده از برآوردگر FIML محدود شده (Diagonal, User-Specified و  User-Factor) با نسخههای ایویوز قبل (نسخههای قبل از نسخه 10) قابل انجام نیستند.
[bookmark: _Toc109603265]سایر گزینهها
برای حداقل مربعات وزنی، SUR، TSLS وزنی، 3SLS، GMM و سیستمهای معادلات غیرخطی، گزینههای اضافی بیشتری برای کنترل روش برای محاسبه ماتریس GLS وزنی و بردار ضرایب وجود دارد. همچنین برای سیستم ARCH، بردار ضرایب در برآورد استفاده میشود. به عنوان به خوبی به عنوان پیش فرض و گزینه های خطای استاندارد.
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بخش Option در پنجره برآورد، روش تکرار ضرایب، ماتریس وزنی و یا هر دو را مشخص میکند. حالت پیش فرض این گزینه بر روی Update weights once, then—Iterate coefs to convergence قرار دارد.
در حالت پیش فرض ایویوز تخمین مرحله اول  (First-Stage)  را با استفاده از ماتریس غیر وزنی انجام میدهد. با استفاده از مقادیر اولیه حاصل از OLS (یا TSLS در صورتی که ابزار وجود دارد)، ایویوز تخمین مرحله اول را تا زمانی که ضرایب همگرا شوند ادامه میدهد. در صورتی که تصریح خطی باشد، این روش شامل یک رگرسیون تک معادله OLS یا TSLS است. باقیماندههای تخمین مرحله اول برای ایجاد یک برآورد سازگار با ماتریس وزنی استفاده میشود. 
در تخمین مرحله دوم[footnoteRef:47] ایویوز از ماتریسهای وزندهی شده در ایجاد برآورد ضرایب جدید استفاده میکند. اگر تصریح غیر خطی باشد، برآورد تا همگرا شدن ضرایب تکرار خواهد شد. [47:  Second Stage] 

گزینههای Update weights once و  then—Update coefs once برآوردهای مرحله اول را انجام میدهد و ماتریس وزنی را برآورد میکند. ایویوز همگرایی ضرایب را تکرار نمیکند، بلکه یک مرحله تکرار ضرایب تک مرحلهای را انجام میدهد. 
از آنجا که ضرایب مرحله اول سازگار هستند، این آپدیت یک مرحلهای به طور صحیح سازگاراست، اما اگر اینکه تصریح خطی باشد، نتایجی را که مشابه روش اول باشد، تولید نمیکند.
توجه داشته باشید که تمام چهار روش برآورد، نتایجی را به دست میدهند که کارایی بالایی دارند. برای مدلهای خطی، دو گزینه Iterate Weights and Coefs معادل هستند و دو گزینه One-Step Weighting Matrix معادل هستند، زیرا ضرایب برآورد شده نیازی به تکرار ندارد. 
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زمانی روش ARCH انتخاب میشود مجموعه گزینههای زیر ارائه میشود:
گزینه Starting Coefficient Value نشان میدهد  که چه مقدار شروع برای شروع فرایند تکرار در ایویوز موردنیاز است. به طور پیش فرض این مورد بر روی گزینه EViews Supplied وجود دارد. شما همچنین میتوانید گزینه User Supplied را برای که به شما اجازه میدهد تا ضریب شروع خود را از جزء ثابت (C) یا سایر گزینههای در دسترس انتخاب کنید.
· گزینه Coefficient name نام ضرایب مورد استفاده در معادله واریانس را مشخص میکند که میتواند متفاوت از میانگین معادله باشد. 
· گزینه Starting (Presample) Covariance نشاندهنده روشی است که باید واریانس شرطی نمونه و نوآوری مورد انتظار محاسبه شود.

[bookmark: _Toc109603266]مروری بر یک مثال تجربی
[bookmark: _Toc109603267]مثال تجربی گرین (1997)
در ادامه برای نکمیل بحث یک مثال تجربی ارائه میشود که با استفاده از دادههای از برندت و وود[footnoteRef:48] (1975) به که توسط گرین[footnoteRef:49] (1997) ارائه شده است و به صورت زیر است:[footnoteRef:50] [48:  Berndt and Wood]  [49:  Greene]  [50:  دادههای مورد استفاده در این مثال در سایت ایویوز و تحت عنوان “G_cost.WF1” موجود است.] 

[image: ]
در این معادله به ترتیب Ci  و Pi به ترتیب هزینه و قیمت فاکتور i است. همچنین  نیز پارمترهایی هستند که باید برآورد شود. توجه داشته باشید که محدودیت ضریب معادله متقابل وجود دارد که متضمن تقارن مشتقات جزئی متقابل است. 
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در مرحله ابتدا پنجره سیستم را مطابق معادلات بالا به صورت زیر تکمیل کنید:
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مدل ابتدا با حداکثر احتمال اطلاعات کامل (FIML) [footnoteRef:51]برآورد میشود. نتایج برآورد به صورت زیر خواهد بود:  [51:  Full Information Maximum Likelihood] 
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برای آزمون محدودیتها مسیر زیر باید طی شود: 
View > Coefficient Diagnostics > Wald Coefficient Test
فیلد زیر را تکمیل کنید و گزینه OK را کلیک کنید:
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نتایج برآورد به صورت زیر خواهد بود:
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با توجه به احتمال برآورد شده که بیشتر از از 05/0 است (93/0)، بنابراین فرضیه محدودیت تقارن مورد آزمون را نمیتوان رد کرد.
برای برآورد محدودیت متقارن اعمال شده بر سیستم معادلات، مسیر زیر را طی کنید: 
Object > Copy Object
و سپس 
View > System Specification
سپس پنجره سیستم را مطابق زیر (یا هر نوع محدودیت دیگری) تغییر دهید:
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در این مورد خاص سیستم مورد نظر SYS_TLOG نامگذاری شده است. 
نکته مهم: محدودیتها با استفاده از ضرایب مشابه در هر معادله اعمال میشود. به عنوان مثال، ضریب log  (P_L / P_M)   در معادله C_K(C (3)) همان ضریب ضریب log (P_K / P_M) در معادله C_L است.
برای برآورد معادله با روش FIML بر روی گزینه Estimate کلیک کنید و گزینه Full Information Maximum Likelihood را انتخاب کنید. برای برآورد معادله روی OK کلیک کنید.
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مقادیر لگاریتم درستنمایی[footnoteRef:52] در قسمت اول در بخش پائینی خروجی گزارش شده است که برای آزمون نسبت درستنمایی ممکن است مورد استفاده قرار بگیرد. [52:  Log Likelihood] 

از آنجا که فرض میشود که توزیع جملات باقیمانده نرمال فرض شده است، ممکن است مایل باشید توزیع جملات باقیمانده نرمال است یا خیر؟ بر روی مسیر زیر کلیک کنید:
Proc > Make Residuals
تا پنجره باقیماندهها باز شود. 
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شما ممکن است گزینه Ordinary  و یا  Standardized Residualsرا انتخاب نمائید. در آخرین بخش نیز نام موردنظرتان را برای سری باقیماندهها که با آن اسم ذخیره شود را وارد نمائید. اسم انتخاب شده در این مورد RESID انتخاب شده است. انتخاب اسامی باید بگونهای باشد که در زمان استفاده مشخص باشد که باقیمانده متعلق به کدام برآورد است؛ زیرا باقیماندهها برای برآوردهای مختلف، تغییر میکند. 
در مثال مورد بررسی گزینه پرکاربرد Ordinary Residuals انتخاب شده است. همچنین برای محاسبه آمار توصیفی برای هر یک از سریهای مورد استفاده ابتدا برو روی متغیر مورد نظر دوبار کلیک کنید و سپس مسیر زیر را طی کنید: 
View > Descriptive Stats > Common Sample
نتایج به صورت زیر خواهد بود:
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در این پنجره، میانگین، مد، ماکزیمم، مینمم و .... برای هر متغیر محاسبه میشود. همچنین در خروجی بالا آمار Jarque-Bera فرضیه نرمال بودن توزیع را آزمون میکند. فرضیه صفر این آزمون نرمال بودن توزیع است. اگر مقدار احتمال بالای 5 درصد باشد فرضیه توزیع نرمال پذیرفته میشود. در مثال بالا به ترتیب سه سری RESID1، RESID2 و RESID3 نرمال، غیرنرمال و نرمال هستند.
برآورد ضرایب از تابع هزینه ترانسلوگ ممکن است برای برآورد کشش جانشینی بین عوامل تولید مورد استفاده قرار بگیرد. به عنوان مثال، کشش جانشینی بین سرمایه و کار[footnoteRef:53] توسط عبارت: [53:  Capital and Labor] 

1+c(3)/(C_K*C_L)
محاسبه میشود. توجه داشته باشید که کشش جانشینی ثابت نیست و به مقادیر C_K و C_L بستگی دارد. مسیر:
Quick > Generate Series
انتخاب کنید و عبارت: 
es_kl = 1 + sys_tlog.c(3)/(c_k*c_l)
 را وارد کنید. برای مشاهده کشش جانشینی بین سرمایه و نیروی کار در در هر مشاهده، دوبار بر روی سری ES_CL در فایل کاری کلیک کنید و مسیر زیر را طی کنید:
View/Graph/Line & Symbol
[image: ]
در حالی که کشش جانشینی مورد بررسی در نمونه متغیر است، کشش جانشینی به طور کلی نزدیک به یک است که مطابق با فرضیه هزینه تابع کاب-داگلاس[footnoteRef:54] است. [54:  Cobb-Douglas Cost Function] 

[bookmark: _Toc109603269]مثال تجربی با System ARCH
در این بخش یک مثال برای برآورد سیستم ARCH ارائه میشود:
در این مثال از دادههای بازدهی هفتگی ین ژاپن (jyt)، فرانک سوئیس(sft) و پوند انگلیس (bpt) استفاده میشود.[footnoteRef:55] [55:  دادههای مورد استفاده در این مثال در سایت ایویوز و با نام فایل کاری “Fx.WF1” شناخته میشود. ] 

معادلات مورد بررسی به صورت زیر است:
[image: ]
کوواریانس شرطی با استفاده از یک VECH قطری پایه مدلسازی میشود: 
[image: ]
برای برآورد این مدل، یک سیستم (SYS01) با مشخصات زیر ایجاد کنید:
dlog(jy) = c(1)
dlog(sf) = c(2)
dlog(bp) = c(3)
این مدل را از گزینه ARCH - Conditional Heteroskedasticity از پنجره برآورد انتخاب کنید. از آنجا که هدف برآورد Diagonal VECH است، بیشتر تنظیمات رد این حالت قرار داده میشود. در بخش Sample، نمونه را به "2000 1980" تغییر دهید تا فقط بخشی از نمونه مورد استفاده قرار بگیرد. بر روی گزینه OK کلیک کنید تا سیستم تخمین بزنید. 
[image: ]

ضرایب واریانس در همین بخش نمایش داده میشود. ضرایب C (4) تا C (9) ضرایب برای ماتریس ثابت، C (10)  تا C (15)  ضرایب جملات ARCH و C (16) از طریق C (21) ضرایب برای جملات GARCH است.
توجه داشته باشید که تعداد ضرایب واریانس در یک مدل ARCH میتواند بسیار بزرگ باشد. حتی در این سیستم کوچک 3 متغیره، 18 پارامتر تخمین زده میشود، و تفسیر آن تا حدودی دشوار است. برای کمک در تفسیر نتایج، ایویوز برای این حالت، یک بخش مشخصات کوواریانس را در انتهای خروجی برآورد ارائه میکند که برچسب های مجدد و ضرایب را تغییر میدهد:
[image: ]
خط اول این بخش، مدل کوواریانس مورد استفاده در برآورد را مشخص میکند، در این موردبر روی گزینه VECH Diagonal قرار دارد. خط بعدی توضیح مدل است که ما در فرم متن اختصار برآورد ارائه شده است. در این مورد، GARCH ماتریس واریانس شرطی است، "M" ضریب ثابت ماتریس است، A1 ماتریس ضریب برای عبارت ARCH است و B1 ماتریس ضریب برای مدت GARCH است . M، A1، و B1 نیز به عنوان ماتریس نامحدود تعریف شده است. 
سپس، مقادیر برآورد عناصر ماتریس و سایر آمارها نمایش داده میشود. از آنجا که ماتریسهای واریانس نامحدود هستند، مقادیر یکسان هستند و با ضرایب واریانس خام گزارش شده است. به عنوان مثال، M (1،1)، عنصر (1،1) در ماتریس  M، با ضریب خام C (4)، M (1،2)  مربوط به        C (5)، و A1 (1،1)  به C (10)  و ... است. برای ضرایب ماتریسی که رتبه 1 یا رتبه کامل هستند، مقادیر گزارش شده در این بخش، تبدیل به ضریب برآوردی خام شده است. 
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یک رگرسیون تک معادلهای مربوط به معادله واریانس-کووریانس را میتوان با کلیک بر روی مسیر: 
View > Representations
و گزینه Variance and Covariance Equations را کلیک نمائید.
معادلاتGARCH، معادلات واریانس شرطی هستند؛ در حالی که معادلات COV معادلات کوواریانس شرطی هستند. برای مثال GARCH1 واریانس شرطی ین ژاپن است و  COV1_2 کوواریانس شرطی بین ین ژاپن و فرانک سوئیس است. 
قبل از ادامه ادامه دادن، سیستم (SYS01) را با کلیک بر روی دکمه Name و پذیرش نام پیشفرض یا انتخاب اسم جدید نامگذاری میکنیم.
یک نمودار واریانس شرطی میتواند با استفاده از کوواریانس و با مسیر  View / Conditional ایجاد شود. لیست گستردهای از گزینهها، از جمله کوواریانس، همبستگی، انحراف، و انحراف استاندارد دادهها در دسترس است. در اینجا بخش همبستگی ارائه شده است: 
[image: ]
به نظر میرسد همبستگی در طی زمان متغیر است، که یک ویژگی کلی این مدل است.
امکان دیگر این است که ماتریس کوواریانس را با استفاده از مشخصه CCC، که با گذر زمان همبستگی ثابت دارد، مدلسازی کرد.ا با ایجاد یک سیستم جدید با مشخصات مشابه آنچه که در بالا آمده است ادامه میدهیم. در ادامه گزینه   Constant Conditional Correlationو برای زمان گزینه Model Type و سایر تنظیمات باقیماندهها را همانطور که هستند قرار دهید. نتایج اساسی به صورت زیر است: 
[image: ]
توجه داشته باشید که این مشخصه فقط 12 پارامتر آزاد در معادله واریانس دارد، در مقایسه با 18 پارامتر که در مدل قبلی. بخش واریانس توسعه نشان دهنده معادله واریانس است:
GARCH(i) = M(i) + A1(i)*RESID(i)(-1)^2 + B1(i)*GARCH(i)(-1)

در حالی که مدل معادله کوواریانس به صورت زیر است: 
COV(i,j) = R(i,j)*@SQRT(GARCH(i)*GARCH(j))

بخش پایینتر خروجی نشان میدهد که همبستگی  R(1, 2)، (1, 3)R  و R(2, 3) به ترتیب برابر با  5713/0، 4032/0- و 6773/0- است:
[image: ]
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آیا این مدل بهتر از مدل قبلی است؟ در حالی که لگاریتم درستنمایی کمتر است، ضرایب کمتر نیز دارد.  میتوانیم با نگاه کردن به معیارهای انتخاب مدل، دو سیستم را مقایسه کنیم. مقادیر آمارههای آکائیک، شوارز و هنانکوئین نشان میدهند که هر سه شاخص معیار اطلاعاتی برای مدل VECH نسبت به مدل CCC کمتر است. این موارد پیشنهاد میکند که مدل تغییر زمان VECH بهتر بوده است. 
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روش رگرسيون آستانهاي[footnoteRef:56] ارائه شده توسط هانسن[footnoteRef:57] (1999)، به دنبال پاسخ به اين سوال است که آيا توابع رگرسيوني به طور يکنواخت از همهي مشاهدات عبور ميکند يا ميتواند به گروههاي مجزا شکسته شوند؟ تجزيه و تحليل سنّتي روابط غيرخطي معمولاً بر اساس رهيافت تقسيم نمونه به دو گروه به صورت برونزا است که بر پايهي داوري و ترجيحات فردي استوار است. در صورت استفاده از اين روش، انتخاب تعداد رژيمها و محل آن اختياري و بر اساس تئوری اقتصادي قبلي است. از اینرو در اين صورت، صحت نتايج و پارامترهاي تخمين زده شده چاش برانگيز است، زيرا به طور وسيعي به انتخاب نقطهاي که آستانه در آنجا رخ ميدهد، وابسته است. [56:  Threshold Regression]  [57:  Hansen] 

روش ديگري که در تجزيه و تحليل هاي آستانهاي مورد استفاده قرار ميگيرد، روش رگرسيوني پيدرپي يا درخت رگرسيوني است که شمار و محل آستانهها را به طور کاملاً درونزا و با بهرهگيري از مرّتبسازي دادههاي موجود تعيين ميکند (لي و ونگ،[footnoteRef:58]2005). اين بحث به طور جدي توسط هانسن[footnoteRef:59] (1997، 1999 و 2000) با ارائهي يک تکنيک جديد در اقتصادسنجي توسعه داده شده است. از مزاياي ديگر اين روش اين است که تصوّرات ذهني در شکلگيري نوع رابطه غيرخطّي دخالتي نداشته و نياز به هيچگونه فرم تابعي معين غيرخطّي در بررسي روابط غيرخطّي ندارد. [58:  Lee and Wong]  [59:  Hansen] 

اگر دادههاي ترکيبي متعادل به صورت {yit , qit , xit :1≤i<n , 1≤t<T} باشند که انديس i نشان دهنده مقاطع و انديس t نمايانگر زمان است. متغيّر وابسته  yitو متغيّر آستانهاي qit اسکالر هستند در صورتي که رگرسور xit يک بردار است. فرم ساختاري اين مدل به صورت زير است:
	
	


که در آن I(0) تابع شاخص است.
مشاهدات بر اساس اينکه متغيّر آستانه کمتر يا بيشتر از γ آستانهاي است، به دو رژيم تقسيم ميشوند. اين رژيمها توسط تفاوت شيبهاي رگرسيون  و  مشخص ميشوند. شناسايي  و  مستلزم آن است که عناصر  در طول زمان تغييرناپذير نباشند. همچنين فرض شده است که متغيّر آستانهاي نيز در طول زمان تغيير ناپذير نيست. در مورد جملهي خطاي ، فرض شده است که غيروابسته و به طور يکسان توزيع شده است و داراي ميانگين صفر و واريانس محدود 2σ است. 
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برای شروع فرایند تخمین در نرمافزار ایویوز  یکی از دو مسیر زیر را  در منوی اصلی ایویوز طی کنید:
Object > New Object > Equation 
یا
 Quick > Estimate Equation
سپس گزینه Threshold - Threshold Regression را در نوار کرکرهای در بخش Method انتخاب کنید. همچنین به عنوان یک روش جایگزین میتوانید در بخش فرمان ایویوز عبارت Threshold را تایپ کنید و کلید Enter را کلیک کنید تا پنجره زیر باز شود:
[image: ]
در پنجره باز شده دو Tab اصلی شامل  Specificationو  Optionsوجود دارد.
[bookmark: _Toc109603275]بخش Specification
در اینجا سه بخش مجزا در صفحه مشخصات رگرسیون آستانه وجود دارد: مشخصات معادله، مشخصات آستانه و مشخصات نمونه. در بخش Equation specification متغیر وابسته را وارد کنید و یک لیست از ضرایب خاص آستانه را وارد کنید. متغیرهای توضیحی ممکن است شامل وقفه متغیرها باشد که در مدلهای آستانه رایج است.
در بخش Threshold Variable Specification  شما باید مشخصات یک یا چند متغیر آستانه را وارد کنید. شما میتوانید این خصوصیات را به عنوان یک یا چند عدد صحیح یا یک لیست از متغیرها را ارائه دهید:
· اگر شما یک عدد صحیح را وارد کنید، ایویوزاین  مقدار را به عنوان پارامتر وقفه در یک مدل SETAR  تفسیر میکند. بنابراین، اگر متغیر وابسته ی شما Y باشد و شما در Threshold variable specification عدد 3 را وارد می شوید، ایویوز این عدد را Y(-3) و به عنوان متغیر آستانه استفاده میکند.
· اگر شما نام یک متغیر را وارد کنید، ایویوز از این متغیر به عنوان متغیر آستانه استفاده خواهد کرد. بنابراین، اگر شما "W" را وارد کنید، ایویوز  W را به عنوان متغیر آستانه برآورد میکند.
· اگر شما یک یا چند متغیر وقفه را وارد کنید، ایویوز از تخمین مدل برای بهترین وقفه در میان وقفههای وارد شده عمل میکند. به عبارتی اگر شما در بخش Threshold Variable Specification اعداد" 1، 4، 7، 9" را وارد کنید و مدلهای SETAR را برآورد کنید ایویوز اعداد بین هر جفت عدد را نیز به عنوان متغیر در نظر میگیرد (یعنی متغیرهای آستانه در این حالت شامل {Y(-1), Y(-2), Y(-3), Y(-4), Y(-7), Y(-8), Y(‑9)} است و متغیر آستانه بهینه را با استفاده از مجموع مربع باقیماندهها تعیین میکند.
· اگر شما بیش از یک متغیر را تعیین با ارائه لیستی از نام ها وارد کنید ایویوز مدلهای TR ایویوز از هر کتغیر به عنوان متغیر آستانه برآورد میکند و انتخاب مدل با استفاده از حداقل مجموع مربع باقیماندهها تعیین میشود.
معیار انتخاب مدل مناسب، مجموع مربعات باقیماندهها (SSR) [footnoteRef:60]است .همچنین توجه داشته باشید که مشخصات آستانه شما ممکن است مشخصات عدد صحیح و لیست متغیر صریح را ترکیب نکند. [60:  Sum of the Squares of the Residuals] 
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صفحه Option شامل تنظیمات اضافی برای محاسبه ماتریس کوواریانس ضریب، تعیین آستانهها و نام ضرایب است. در ادامه شرح مختصری از روشهای آستانه ارائه میشود.
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ایویوز گزینههای متعددی برای انتخاب تعداد و مکان مقادیر آستانه ارائه میدهد.
اگر تعداد آستانهها شناخته شده باشد، می توان آن را به عنوان یکی از گزینههای مشخص شده "Fixed Number" وارد کرد.
قبل از بیان روشهای دیگر، مهم است توجه داشته باشید که ایویوز برای تعیین تعداد آستانهها از روششناسی بای و پرون[footnoteRef:61] (1998) استفاده میکند و نه آزمون بوت استرپ ثابت پیشنهاد شده توسط هانسن (1999) که اعتبار کمتری نسبت به رویکرد بای و پرون (1998) دارد. برای یک برآورد کلی تخمین آستانه، SSRها را برای تمام مجموعههای ممکن از مقادیر آستانه مقایسه میکند. روشهای مرسوم زیر برای تعیین مقادیر آستانه و ضرایب رگرسیون مرتبط استفاده میشود. در دو روش اول تعداد آستانه ها نامشخص است و کاربر باید حداکثر تعداد آستانههای مجاز را تعیین کند کند. روش آخر نیز تعداد مورد نیاز آستانه باید وارد شود که در ادامه مرور میشود: [61:  Bai and Perron] 

· آستانه های جهانی L در مقابل هیچ کدام[footnoteRef:62] [62:  Global Thresholds Versus None] 

· حداقل معیارهای اطلاعات[footnoteRef:63] [63:  Minimizing the Information Criteria] 

· تعداد ثابت[footnoteRef:64] [64:  Fixed number ] 

مقادیر آستانه همچنین ممکن است به صورت آزمونهای متوالی و با پیدا کردن یک مقدار آستانه اولیه، به حداقل رساندن مجموع مربع باقیماندهها و سپس جستجوی مقادیر اضافی (با توجه به مقدار اولیه) که SSR را به حداقل برساند تا تعداد آستانه مورد نظر که احتمالاً از طریق آزمون تعیین میشود، به دست آید. آزمونهای متوالی در روشهای زیر استفاده میشود. باز هم، در دو روش اول، تعداد آستانه ها نامشخص است و کاربر باید حداکثر تعداد آستانههای مجاز را وارد کند و در آخرین مورد، کاربر باید تعداد دلخواه آستانه را وارد کند:
· شکستهای متولی L+1 در مقابل L
· آزمونهای متوالی تمام زیر مجموعهها موجود
· تعداد ثابت – متوالی (پی در پی)
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[bookmark: _Toc109603280]مقدمه
گاهی در مطاالعات در حوزه اقتصادی و مالی حالتهایی وجود دارد که در آن دادهها ترکیبی از عناصر سریزمانی و عناصر مقطعی هستند. اینگونه دادهها با اسامی مختلفی از قبیل دادههای، ترکیبی، پانل، تابلویی[footnoteRef:65] یا دادههای طولی[footnoteRef:66] نیز شناخته میشوند. از بعد آماری، این مجموعه دادهها دارای یک ویژگی مهم هستند و آن مبتنی بودن آنها بر نمونهگیری مشاهدات به طور مستقل است. هم چنین استقلال، ویژگی کلیدی تحلیل دادههای مقطعی است که باعث عدم وجود همبستگی بین جملات اخلال در بین مشاهدات مختلف میشود. یک مجموعه داده مقطعی، مستقلاً آمیخته با یک نمونه تصادفی منفرد متفاوت است چرا که احتمالاً نمونهگیری از یک جامعه در زمانهای متفاوت، مشاهداتی را بهدست نمیدهد که به طور مستقل توزیع شده باشند. نکته مهم آن است که دادههای ترکیبی حاوی افراد و اشیاء مشابهی است (که مقطع[footnoteRef:67] نیز نامیده میشوند، مانند کشور، شرکت، بنگاه، فرد و ...).  [65:  Panel of Data]  [66:  Longitudinal Data]  [67:  Entities] 

در این فصل به بحث و بررسی برآورد دادههای پانلی، انواع مختلف روش دادههای ترکیبی و همچنین موضوعات مرتبط با این دادهها  مرور خواهد شد. 
[bookmark: _Toc10909949]در این بخش  در ابتدا ابتدا ورود دادهها در نرمافزار ایویوز با رویکرد پانل و برآوردهای آن شرح داده خواهد شد. 
[bookmark: _Toc109603281]کار با نرمافزار
[bookmark: _Toc10909950][bookmark: _Toc109603282]ورود داده به صورت Panel
برای ورود داده به صورت پانل، به مسیر زیر را طی کنید:
File > New > Workfile
کادر زیر باز میشود:
[image: ]
برای ورود داده صورت Panel در قسمت Workfile Struture Type گزینه Balance Panel را انتخاب کنید. در قسمت راست نوع داده که سالانه، ماهانه، روزانه و .... است را مطابق با داده خود انتخاب کنید. در بخش Start Date سال شروع داده، در قسمت End Date سال پایان و در قسمت Number of Cross Section تعداد شرکتها، کشورها یا افراد را انتخاب کنید. کادر زیر به عنوان یک مثال پر شده است:
[image: ]
در بخش Workfile Name میتوانید برای فایل کاری خود یک اسم انتخاب کنید. البته پر کردن این بخش الزامی نیست و ایویوز در صورت خالی بودن آن اسم عنوان پیش فرضی برای آن در نظر میگیرد.
سپس OK را کلیک کنید. تا فایل کاری ساخته شود.
[bookmark: _Toc10909951][bookmark: _Toc109603283]تصریح مدل
[bookmark: _Toc10909952][bookmark: _Toc109603284]مثالهای حداقل مربعات
برای نشان دادن برآورد معادلات پانل در ایویوز، ابتدا نمونهای از دادههای پانل نامتوازن از هریسون و روبینفلد[footnoteRef:68] (1978) برای مطالعه قیمت هدانیک در نظر گرفته میشود.[footnoteRef:69] این دادهها در کتاب بالتاجی (2005) نیز ارائه شده است. [68:  Harrison and Rubinfeld]  [69:  این دادهها با عنوان Harrison_panel.WF1 در سایت ایویوز موجود است.] 

[image: ]

دادهها شامل 506 مشاهده در 92 شهر در منطقه بوستون با اندازههای گروهی از 1 تا 30 است. متغیر وابسته لگاریتم ارزش واحد مسکونی مورد استفاده (MV) است و رگرسورها (متغیرهای مستقل)، بقیه متغیرهای موجود در فایل کاری است. 
گزینه Undated Panel را انتخاب کنید و عبارت “TOWNID” به عنوان شناسه سری (Identifier series) وارد کنید.
پس از تغییرات بالا فایلهای کاری بازسازی میشود؛ به طوری که یک فایل کاری پانل نامتوازن است. بخش بالای پنجره فایل کاری تغییر خواهد کرد تا ساختار بدون تاریخ که دارای 92 مقطع و حداکثر 30 مشاهده در  هر مقطع است که بهصورت زیر نمایش داده شده است:
[image: ]
در مرحله بعد مسیر:
Quick > Estimate Equation
را برای تصریح معادله طی کنید تا پنجره زیر باز شود:
[image: ]
با تبعیت از بالتاجی (2005)، معادله تصریح شده با استفاده از اثرات ثابت برآورد میشود.  در این مثال متغیر وابسته MV، جزء ثابت C و سایر متغیرای پس از آن رگرسورها  (متغیرهای مستقل) هستند.
برای برآورد معادله با اثرات ثابت بر روی Panel Options در پنجره تصریح معادله کلیک کنید و سپس Cross-Section را بر روی Fixed قرار دهید. با کلیک بر روی گزینه OK نتایج برآورد با اثرات ثابت ارائه خواهد شد.
[image: ]
نتایج برای برآورد اثرات ثابت در اینجا نشان داده شده است .توجه داشته باشید که  آمار R-Squared و F  گزارش شده است که دارای تفسیری مشابه فصول قبل است.  همچنین معیارهای اطلاعات (آکائیک، شوارز، و هنان –کویین) گزارش شده است. در نهایت دورتبین-واتسون گزارش شده است که بیانگر عدم وجود خودهمبستگی در باقیماندههای مدل است. زیرا مقدار قابل قبول برای وجود عدم خودهمبستگی بین جملات اخلال در آستانه 10/2-9/1 قرار گرفته است
در صورتی که مایل به تغییراتی در تصریح مدل باشید و یا بخواهید شیوه برآورد را تغییر دهید، بر روی گزینه Estimate کلیک کنید تا پنجره تصریح معادله باز شود. متغیرهای مستقل ZN, INDUS, RAD, TAX و PTRATIO را به معادله اضافه کنید و سپس از بخش Option برآورد را بر روی Random قرار دهید تا برآورد به صورت تصادفی انجام شود. گزینه OK را کلیک کنید تا نتایج به صورت تصادفی ارائه شود:
[image: ]
در گام بعدی بعد، یک مثال از برآورد را با خطاهای استاندارد که به نسبت به خودهمبستگی مقاوم شده است را نشان خواهیم داد. برای این مثال، از دادههای ولدریج[footnoteRef:70] (2002) استفاده میشود.[footnoteRef:71] [70:  Wooldridge]  [71:  این دادهها با عنوان (("Jtrain.WF1" قابل دسترسی است.] 

[image: ]
همانند مثال قبل باید ابتدا فایل داده را به صورت فایل کاری پانل تنظیم کنید. بر روی Range در ابتدای پنجره کلیک کنید و عبارت “YEAR” را به عنوان زمان و عبارت “FCODE” را به عنوان شناسه مقطع وارد کنید. 
[image: ]
ایویوز فایل کاری را برای 157 مقطع و دوره زمانی 1989-1987 تنظیم میکند. البته تعدادی از متغیرهای در این بازه زمانی دارای مشاهدات مفقوده هستند.
[image: ]
برای برآورد معادله با اثرات ثابت که نسبت به خودهمبستگی مقاوم شده است (مثال 5-10  در صفحه 276 ولدریج (2002)). مسیر: 
Quick > Estimate Equation
از بخش منوی ایویوز انتخاب کنید و لیست تصریح مدل را انتخاب کنید. 
lscrap c d88 d89 grant grant_1

در بخش Equation Specification تصریح معادله را وارد کنید و از بخش Panel Options، مقطع را بر روی Fixed قرار دهید.
در نهایت ممکن است شما مایل باشید خطاهای استاندارد مقاوم شده نسبت به خودهمبستگی را محاسبه کنید. برای این منظور در نوار کرکرهای Coef Covariance Method گزینه White Period را انتخاب کنید. همچنین تیک مربوط به No d.f. correction برای محاسبه کوورایانس فعال نشده است.
گزینه OK را کلیک کنید تا نتایج برآورد ارائه شود:
[image: ]
توجه داشته باشید که ایویوز به طور خودکار برای مقادیر گم شده در دادهها تنظیم میشود. تنها 162 مشاهده در 54 مقطع مورد استفاده در برآورد وجود دارد. بخش بالای خروجی نشان میدهد که نتایج با استفاده از خطاهای استاندارد مقاوم شده انجام شده است. توجه داشته باشید که ایویوز هشدار میدهد که ضرایب برآورد شده Covariances از رتبه کامل ّرخوردار نیستند که این مورد بیشتر زمانی رخ می دهد که تعداد دورهها کمتر از تعداد مقاطع است. همچنین با کلیک بر روزی مسیر: 
Quick > Estimate Equation
میتوان برای تغییر روش برآورد معادله اقدام کرد. همچنین میتوان در همین بخش تصریح معادله را تغییر داد.  تصریح زیر را در بخش معادله وارد کنید:
d(lscrap) c d89 d(grant) d(grant_1)
در پنجره Equation Specification در بخش Option در نوار کرکرهای Cross-Section را بر روی None قرار دهید. در بخش Panel Options روش White Period و تیک گزینه No d.f. correction را برای محاسبه کوورایانس ضرایب فعال کنید. نتایج برآورد بهصورت زیر خواهد بود:
[image: ]
نسخههای فعلی ایویوز مجموعهای کامل از آزمونهای تصریح برای معادلات پانل را ارائه نمیکنند. یک راه سادهای برای انجام برخی آزمونها، استفاده از باقیماندههای مدل برآورد شده است. بر روی مسیر:
Proc > Make Residual Series
برای ایجاد سری باقیماندهها کلیک کنید تا یک سری به نام Residual1 تولید شود. سری Residual1 را بر روی وقفه مرتبه اول ((-1) Residual1) رگرس کنید. نتایج به صورت زیر خواهد بود:
[image: ]
فرضیه صفر[footnoteRef:72] این آزمون عدم وجود خودهمبستگی بر جملات باقیمانده مدل است. از آنجا که احتمال مربوط به ضریب (-1) Residual1) بالای 05/0 است، بنابراین فرضیه صفر را نمیتوان در سطح خطای 5 درصد رد کرد. [72:  Null Hypothesis] 

مثالهایی در زمینه متغیرهای ابزاری
برای نشان دادن مثالی در زمینه متغیرهای ابزاری مثالی با 22 مقطع که توسط ولدریج (2002) نیز ارائه شده است، مرور میشود.
[image: ]
فایل کاری برای این مثال با استفاده از عبارت YEAR به عنوان شناسه زمان و CITY برای شناسه مقطع استفاده میشود. این مثال شامل 22 مقطع و دوره زمانی 1988-1980 است که در مجموع حدود 198 مشاهده است. 
برای تصریح مدل در مثال فوق یا عبارت tsls را در بخش فرمان تایپ و زدن دکمه Enter و یا مسیر: 
Quick > Estimate Equation
را از منوی اصلی طی کنید. در منوی اصلی یک معادله جدید ایجاد کنید.
شما میتوانید روش TSLS  و یا  Two-Stage Least Squares را از نوار کرکرهای Method انتخاب کنید. عبارت: 
d(luclms) c d(luclms(-1)) d(ez)
را در پنجره تصریح معادله وارد کنید و گزینه OK را کلیک کنید تا نتایج ارائه شود.
[image: ]
توجه داشته باشید که رتبه ابزار در این معادله 8 است زیرا طول دوره زمانی نیز به عنوان ابزار استفاده می شود.
[bookmark: _Toc109603285]ریشه واحد و همجمعی در دادههای ترکیبی
رشد مطالعات در زمینه دادههای ترکیبی وهمچنین در دسترس بودن دادههای ترکیی موجب تاکید بر گسترش آزمونهای آماری مختلف مرتبط با دادههای ترکیبی شده است ادبیات اخیر بر آزمونهای همجمعی متمرکز شده است. در منوی آزمون همجمعی در ایویوز آزمونهای پدرونی[footnoteRef:73] (1999)، پدرونی (2004)، کائو[footnoteRef:74] (1999) و آزمون Fisher-Type با استفاده از روش یوهانسن وجود دارد (مادالا و وو،[footnoteRef:75] 1999). در فصل قبل مروری بر ریشه واحد و آزمونهای ایستایی شد. در این فصل مروری مختصر بر آزمونهای همجمعی[footnoteRef:76] در دادههای ترکیبی خواهد شد؛ زیرا ممکن است سریهای مورد استفاده در برآورد مدل دادههای ترکیبی همگی ایستا نباشند. از اینرو برای بررسی وجود یا عدم وجود رگرسیون کاذب از آزمونهای همجمعی استفاده میشود. [73:  Pedroni]  [74:  Kao]  [75:  Maddala and Wu]  [76:  Co-integration Tests] 

یک راهحل متداول برای مانا کردن یک سری زمانی ناایستا به یک سری زمانی ایستا، استفاده از روش تفاضلگیری است. در این حالت، برای رهایی از رگرسیون کاذب میتوان از تفاضل مرتبه اول یا تفاضل مراتب بالاتر متغیرها در برآورد مدل استفاده کرد. اما بیشتر تئوریهای اقتصادی براساس رابطه بلندمدت بین سطح متغیرها بیان شده است. از طرفی دیگر زمانی که از تفاضل متغیرهای سری زمانی در برآورد مدل استفاده میشود، اطلاعاتی در رابطه با سطح متغیرها از بین میرود. بههمین دلیل، استفاده از تفاضل متغیرها در برآورد پارامترهای مدل، متداول نیست. بعد از ارائه مفهوم همجمعی در دهه 1980 میلادی، میتوان رگرسیون را بدون ترس از کاذب بودن براساس سطح متغیرهای سری زمانی به شرط وجود همجمعی بین متغیرها، برآورد کرد (اندرز،[footnoteRef:77] 2004). [77:  Anders] 

[bookmark: _Toc10900396][bookmark: _Toc109603286]نحوه انجام آزمونهای ایستایی در دادههای ترکیبی
برای انجام آزمونهای ایستایی در دادههای ترکیبی پس از ورود دادهها همانطور که در فصل سه توضیح داده شد به صورت زیر عمل میکنیم:
بر روی متغیری که میخواهیم آزمون ایستایی بر روی آن انجام دهیم، دوبار کلیک کرده و مسیر زیر را طی میکنیم:
View > Unit Root Test
سپس کادری به صورت زیر باز میشود:
[image: ]
در بخش Summary انواع مختلف آزمونهای ایستایی (مانند دیکی فولر، فیلیپس پرون، لین و لوین و...) وجود دارد. در صورتی که قصد انجام صرفاً یکی از آزمونها را داشته باشیم از این قسمت آزمون مورد نظر را انتخاب میکنیم. چنانچه بخواهیم نتایج تمامی آزمونها را داشته باشیم همان گزینه Default خود نرمافزار بدون تغییر ok میکنیم. 
در منوی Default خود نرم افزار دادههای در سطح (Level)  و حالت فقط عرض از مبدا (Individual intercept) قرار دارد. میتوان این گزینهها را بسته به داده و یا درجه ایستایی تغییر داد. مثلاً ممکن است متغیری با در نظر گرفتن روند (Trend) ریشه واحد نداشته و در غیر اینصورت ریشه واحد داشته باشد. یا متغیری در سطح مانا نباشد اما تفاضل مرتبه اول (1st Difference)  آن ایستا باشد.
به عنوان مثال در صورتی که هدف بررسی ایستایی متغیر CO2 در مثال فصل چهارم باشد به پس از طی مسیر
View > Unit Root Test
گزینه OK را کلیک میکنیم:
[image: ]
نتایج نشان میدهد که بر اساس تمامی آزمونها، متغیر CO2 ناایستا است (زیرا فرضیه H0 رد نشده است). برای تعیین درجه ایستایی متغیر یا به عبارتی تعیین اینکه متغیر با چندبار تفاضلگیری ایستا میشود به صورت زیر عمل میکنیم:
پس از طی مسیر
View > Unit Root Test
در کادر باز شده در قسمت Test for unit Root Test in گزینه 1st Difference  را کلیک کنید. 
[image: ]
در ادامه دکمه ok را کلیک میکنیم:
[image: ]
در این حالت با توجه به اینکه احتمال مربوط به آزمونهای ایستایی زیر 5 صدم است میتوان فرضیه H0 مبنی بر وجود ریشه واحد را رد کرد؛ به عبارت دیگر دادههای با یکبار تفاضلگیری ایستا شدهاند.[footnoteRef:78] [78:  دادهای که با یکبار تفاضلگیری ایستا شود I(1) و دادهای که در سطح ایستا باشد I(0) نامیده میشود.] 

[bookmark: _Toc109603287]نحوه انجام آزمونهای همجمعی در دادههای ترکیبی
انجام آزمونهای همجمعی در ایویوز میتواند در محیط POOL و یا Panel باشد که در اینجا تمرکز آزمونها در محیط Panel است و برای انجام آزمون در محیط POOL نیز برآورد کاملاً مشابه این حالت انجام میگیرد. آزمونهایPedroni  و Kao بر اساس آزمون دو مرحلهای (بر پایه باقیماندهها) انگل گرنجر (1987) است. آزمون Fisher نیز، یک آزمون ترکیبی یوهانسن است.
ابتدا فایل کاری برای دادههای پانل را باز کنید. برای رسیده به پنجره آزمونهای همجمعی مسیر زیر را طی کنید:
View > Cointegration Test > Panel Cointegration Test
[image: ]
در پنجره باز شده گزینههای مختلفی وجود دارد که به ترتیب مرور میشود.
بخش Test Type
در این بخش از بین آزمونهای همجمعی در نوار کرکرهای یکی از سه آزمون همجمعی که شامل Kao، Pedroni و Fisher است، انتخاب میشود. با انتخاب هر یک از آزمونهای همجمعی، پنجره آزمون نیز تغییر میکند. 
توجه مهم: آزمون همجمعی Pedroni فقط برای گروههای دادههای که شامل 7 یا کمتر از هفت سری (متغیر) دارند. و برای مقادیر بالای 7 متغیر آزمون پدرونی در پنجره آزمون ریشه واحد ارائه نمیشود.
گزینههای قابل تنظیم مرتبط با آزمونهای Pedroni و Kao بسیار شبیه به گزینههای موجود در آزمون ریشه واحد پانل است که در فصل سوم مورد بحث قرار گرفته است.
در بخش Deterministic Trend Specification، متغیرهای مستقلی که باید در رگرسیون دو مرحلهای[footnoteRef:79] قرار بگیرند را مشخص کنید. در این حالت برای آزمون همجمعی Pedroni سه گزینه   Individual Intercept، Individual Intercept and Individual Trend و یا گزینه No intercept or trend را انتخاب کنید. به ترتیب گزینه اول فقط اثرات ثابت فردای را لحاظ میکند. گزینه دوم علاوه بر اثرات ثابت فردی، روند فردی را نیز در نظر میگیرد. گزینه سوم نیز بدون اثرات ثابت و روند فردی انجام میگیرد. [79:  Second-Stage Regression] 

بخش Lag length نیز شامل تعداد وقفهها در رگرسیون دو مرحلهای است. اگر گزینه Automatic Selection را انتخاب کنید، ایویوز به طور اتوماتیک تعداد وقفه را براساس معیارهای آکائیک، شوارز و هنانکوئین وارد میکند. در بخش پایینی همین گزینه با عنوان Maximum Lag میتوانید حداکثر تعادا وقفه را مشخص کنید.  حداکثر وقفه برای Cross-Section با استفاده از رابطه زیر محاسبه میشود:
[image: ]
در اینجا Ti، تعداد مقاطع است.
شما همچنین ممکن است بهجای فرایند بالا از گزنه User specified، وقفه مورد نظر خود را به صورت دستی وارد کنید. آزمون Pedroni هر دو برآورد پارامتریک و ناپارامتریک Kernel را برای محاسبه واریانس بلند مدت مورد استفاده قرار میدهد. 
در بخش Spectral Estimation تنظیمات برآورد ناپارامتریک را ارائه میدهد. میتوان از بین گزینههای مختلف در این حالت (Bartlett, Parzen, Quadratic spectral) یک گزینه را انتخاب کرد. 
گزینه Newey-West fixed bandwidth  از طریق رابطه:
[image: ] 
محاسبه میشود. با کلیک بر روی گزینه OK نتایج برآورد ارائه خواهد شد:
[image: ]
آزمون Pedroni شامل 7 آماره است. فرضیه صفر تمام آزمونهای همجمعی، عدم وجود همجمعی است. بنابراین در صورتی که مقدار احتمال آماره محاسباتی کمتر از 05/0 باشد، فرضیه صفر رد و وجود همجمعی پذیرفته میشود. از 7 آماره فوق تنها دو گزینه اول دارای احتمال زیر 05/0 است و وجود همجمعی رد آن پذیرفته میشود برای 5 آماره دیگر نمیتوان فرضیه صفر را رد کرد. 
بخش پایین جدول، نتایج مقطعی کمکی را نشان میدهد. برای آزمون Pedroni این گزینه به دو بخش تقسیم میشود، بخش اول شامل نتایج غیر پارامتریک فیلیپس-پررون است و بخش دوم نتایج پارامتری پیشرفته دیکی-فولر را نشان میدهد.
[image: ]
در ادامه تنظیمات مروبط به آزمون Fisher ارائه شده است:
[image: ]
بخش Deterministic Trend Specification، نوع روند خارجی مورد استفاده را مشخص میکند. بخش Lag Interval، برای تعیین تعداد وقفه مورد نیاز در برآورد مورد استفاده قرار میگیرد سپس گزینه OK را کلیک کنید که تفسیر نتایج مشابه آزمون Pedroni است. 
[bookmark: _Toc10909992][bookmark: _Toc109603288]برآوردگر میانگین گروهی تلفیقی[footnoteRef:80] (PMG) [80:  Panel Mean Group] 

در حال حاضر دادههای پانلی که  بخش سری زمانی نسبتاً بزرگ دارد، به صورت گستردهای مورد استفاده قرار میگیرد. در این حالت میتوان N رگرسیون سری زمانی اجرا کرد و در ادامه میانگین آنها را محاسبه نمود. با برآوردگر میانگین گروهی تلفیقی (PMG) میتوان دادهها را ترکیب کرد و فرض نمود که ضرایب شیب و واریانس آنها مشابه هستند. پسران، شین و اسمیت (1997) با توسعه روش ARDL، این روش را ارائه کردند. در این روش ضرایب شیب بلندمدت مشابه فرض میشوند اما اجازه داده می شود که ضرایب شیب کوتاه مدت و انحراف معیار آنها در بین واحدهای مقطعی تغییر کنند. پسران و همکاران (1997) ویژگیهای مجانبی این برآوردگر زمانی که بعد زمان به سمت بینهایت میرود هم در حالت ایستایی متغیرها و هم در حالت ریشه واحد بودن متغیرها زمانی که تعداد واحدهای مقطعی ثابت است بررسی نمودند. در ادامه مثالی کاربردی برای درک بهتر روش بررسی میشود.
[bookmark: _Toc10909993][bookmark: _Toc109603289]کار با نرمافزار
در این مثال از دادههای استفاده شده برای برآورد توابع مصرف در کشورهای OECD در سالهای 1962-1993 استفاده میشود. [footnoteRef:81] [81:  دادههای این بخش تحت عنوان “OECD.wf1” در سایت ایویوز قایل مشاهده است.] 

برای برآورد به روش PMG در ایویوز مسیر زیر را طی کنید:
Quick > Estimate Equation
سپس از بخش Methods گزینه PMG/ARDL را انتخاب کنید. بخش تصریح معادله  را با استفاده از معادله: 
log(cons) log(inf) log(inc)
پر کنید.
در بخش Dynamic Specification گزینه Fixed را انتخاب کنید. سپس تعداد وقفههای متغیر وابسته را از نوار کرکرهای بخش Dependent Variable Lags بر روی یک قرار دهید. دوره زمانی برآورد در بخش Sample نیز به “1962 1993” تغییر داده شده است. سایر آیتمها را بدون تغییر بگذارید. گزینه OK را برای برآورد معادله کلیک کنید. نتایج بهصورت زیر خواهد بود:
[image: ]
در پنجره برآوردی، رابطه بلندمدت (Long Run Equation)  و رابطه کوتاه مدت (Short Run Equation) ارائه شده است. در رابطه بالا کشش بلند مدت متغیر LogInc برابر با 904/0 شده است.[footnoteRef:82] [82:  زمانی که از دو طرف معاله لگاریتم گرفته میشود، ضرایب برآوردی مفهوم کشش را خواهند داشت. مدلهای کشش ثابت نسبت به مدلهای غیر لگاریتمی برای پیشنهادات سیاستی مناسبتر هستند. همچنین مدلهای لگاریتمی با کاهش دامنه تغییرات متغیرها، امکان حصول نتایجی بهتر با تورش کمتر را میسر میکنند.] 


[bookmark: _Toc109603290]آزمونهای تکمیلی در دادههای ترکیبی
این بخش در ارتباط با برخی مباحث تکمیلی در زمینه دادههای پانل دیتا است. برای این منظور آمارهای توصیفی، نمودارها، آزمونهای وابستگی مقاطع و همچنین همبستگی سریالی از درجات مختلف مورد بحث و بررسی قرار میگیرد. 
[bookmark: _Toc10909997][bookmark: _Toc109603291]نمودارهای سری زمانی
ایویوز، ابزاری برای نمایش نمودارهای سری زمان با داده های پانل را ارائه میکند. از این ابزارها برای نمایش نموداری دادههای پانلی، نمودارهای فردی یا ترکیبی برای هر مقطع استفاده کرد.
برای نمایش نمودارهای پانلی برای یک سری یا گروهی از سریها در یک فایل کاری، پنجره سری یا گروه باز کنید و مسیر زیر را طی کنید:
View / Graph ... 
کلیک کنید و سپس پنجره Dialog Options Graph را انتخاب کنید. در بخش Panel options در سمت راست پایین محاوره، ایویوز گزینههای مختلفی برای چگونگی نمایش دادهها ارائه میدهد.
[image: ]
در این بخش میتوانید از بین گزینههای مختلف و انوع مختلف نمودارها، گزینه مورد نظر را انتخاب کنید. برای مثال با انتخاب Line & Symbol نمودار زیر را خواهیم داشت:
[image: ]
بهصورتی مشابه اگر گزینه Individual cross sections را انتخاب کنید، نمودارهای سری زمانی برای هر مقطع قابل مشاهده است. در ادامه این نمودارها برای 10 مقطع مورد بررسی ارائه شده است:
[image: ]
با اینحال، نمودار شما را قادر میسازد تمام مقاطع خود را در یک نگاه بررسی کنید.
دو گزینه باقیمانده به شما اجازه میدهد یک نمودار واحد حاوی آمار توصیفی برای هر دوره را بررسی کنید. 
[image: ]
در خط نمودار، شما ممکن است گزینه Mean plus SD bounds را انتخاب کنید: سپس از نوار کرکرهای  تعداد Std.Dev. را انتخاب کنید (1، 2 و یا 3). 
همچنین در خط نمودار اگر گزینه Median plus quantiles انتخاب کنید و سپس از نوار کرکرهای مقادیر extreme quantiles را انتخاب کنید. 
[image: ]
فرض کنید در دو حالت بالا، برای سری مورد استفاده (در اینجا سری F) میانه و 2 انحراف استاندارد نمایش داده شود. نتایج بهصورت زیر خواهد بود:
[image: ]
و در صورت انتخاب میانه، نتایج بهصورت زیر خواهد بود:
[image: ]
[bookmark: _Toc10909998][bookmark: _Toc109603292]آمار توصیفی
برای داشتن یک دید کلی در زمینه دادههای مورد استفاده در یک فایل کاری پانلی میتوانید به آمار توصیفی متغیرها مراجعه کنید. برای این منظور میتوانید پس از باز کردن سری موردنظر، مسیر زیر را طی کنید:
View > Stats by Classification ...
پنجره زیر باز میشود:
[image: ]
در پنجره باز شده، میتوانید مواردی مانند ، میانگین، مجموع، میانه، ماکزیمم و ... را انتخاب کنید. بهعنوان مثال در پنجره بالا گزینههای میانگین، انحراف استاندارد و تعداد مشاهدات انتخاب شده است. 
نکته بسیار مهم: در صورتی که مایل باشید نتایج آمار توصیفی برای هر مقطع نیز ارائه شود در همین پنجره و در بخش Series/ Group for Classify، دستور @crossid را وارد کنید. در این صورت نتایج آمار توصیفی برای هر مقطع و همچنین برای کل نمونه ارائه میشود.
[image: ]
در صورتی که مایل به بررسی آزمون برابری میانگین مقاطع هستید، مسیر زیرا را طی کنید:
View < Equality Tests by Classification...
برای این منظور سری مورد نظر را باز کنید و سپس مسیر زیرا را طی کنید:
View > Descriptive Statistics & Tests < Equality Tests by Classification....
در فیلد Series > Group for Classify، FN را وارد کنید و سپس OK را کلیک کنید. نتایج آزمون ANOVA برای سری F ارائه خواهد شد:
[image: ]
[bookmark: _Toc10909999][bookmark: _Toc109603293]کوواریانس 
برای محاسبات کوواریانس در دادههای پانلی، بهصورت زیر عمل کنید:
[image: ]
مطابق شکل بالا، گزینه View و سپس Panel Covariance را انتخاب کنید. پنجره زیر باز میشود:
[image: ]
پنجره پائین باز میشود. موارد مورد نظر را میتوانید انتخاب و سپس گزینه OK را کلیک نمائید. 
[image: ]
نتایچ بهصورت زیر ارائه خواهد شد:
[image: ]
مسیر بالا همبستگی بین مقاطع را برای متغیر مورد بررسی نشان میدهد. 
در صورتی که مایل باشید کوواریانس بین زمانها (Periods) را انجام دهید، پنجره باز شده را مطابق شکل زیر پر کنید:

[image: ]
در صورتی که گزینه OK را کلیک نمائید، ماتریس همبستگی بین زمانی (“1972 1992”) ارائه خواهد شد.
[bookmark: _Toc10910000][bookmark: _Toc109603294]واریانس بلندمدت پانل[footnoteRef:83] [83:  Panel Long-Run Variances] 

تفاوتهای جزئی در محاسبات واریانس و کوواریانس بلند مدت در دادههای پانلی و غیر پانلی وجود دارد. در مثال مورد بررسی یک گروه از دو سری LCARPCAP  و  LGASPCARتشکیل شده است. پس از باز کرده دو سری فوق، مسیر زیر را طی کنید:
View > Long-run Covariance
برای نمایش پنجره در بخش Panel Matrix، عبارت “pan_results” را وارد کنید. 
[image: ]
سپس OK را کلیک نمائید:
[image: ]
نتایج بهصورت بالا خواهد بود:
نتایج انفرادی برای مقاطع هم در سری PAN_RESULTS ذخیره خواهد شد. 
[image: ]
[bookmark: _Toc10910001][bookmark: _Toc109603295]آزمونهای وابستگی مقاطع
ایویوز برای بررسی وابستگی بین مقاطع چندین آزمون به شرح زیر ارائه میکند:
Breusch-Pagan (1980) LM
Pesaran (2004) scaled LM
Baltagi, Feng, and Kao (2012) bias-corrected scaled LM
Pesaran (2004) CD
برای بررسی وابستگی مقاطع، پس از برآورد مدل، مسیر زیر را طی کنید: 
View > Residual Diagnostics > Cross-section Dependence Test
[image: ]
با طی مسیر بالا، ایویوز نتایج آزمون وابستگی مقاطع را بهصورت زیر ارائه خواهد داد:
[image: ]
فرضیه صفر این آزمون عدم وابستگی بین مقاطع در باقیماندهها است. در صورت رد فرضیه صفر، وابستگی بین مقاطع پذیرفته میشود.[footnoteRef:84] [84:  در آزمونهای آماری در ایویوز در صورتی که میزان Prob زیر 05/0 باشد فرضیه صفر در سطح 05/0 خطا (95 درصد اطمینان) رد میشود.] 

[bookmark: _Toc10910002][bookmark: _Toc109603296]آزمون همبستگی سریالی آرلانو و باند[footnoteRef:85] [85:  Arellano-Bond Serial Correlation Testing] 

در هنگام برآورد مدلها با استفاده از روش GMM، باید پس از برآورد مدل، نتایج خودهمبستگی مرتبه اول، دوم و یا بالاتر را آزمون کنید.  ای آزمون توسط آرلانو و بوند (1991) ارائه شده است.  برای انجام آزمون فوق، پس از برآورد مدل، مسیر زیر را طی کنید:
View > Residual Diagnostics > Arellano-Bond Serial Correlation Test

[image: ]
با توجه به مقدار Prob، همبستگی سریالی از درجه 1 وجود دارد اما از درجه 2 وجود ندارد. 
[bookmark: _Toc109603297]آموزش دانلود داده از منابع معتبر
جمعآوری داده برای یک پروژه کلاسی غالبا آموزنده، جالب و برخی مواقع مشکل است. شما باید ابتدا تصمیمگیری کنید چه نوع دادهای برای پاسخ به سوالات تحقیق لازم است. در ادامه توضیح خواهیم داد که مجموعههای مختلفی از دادهها وجود دارند که عمومیترین انواع آنها عبارت از دادههای مقطعی، سریهای زمانی، دادههای مقطعی آمیخته و دادههای ترکیبی است. سوالات زیادی میتوانند به کمک هر یک از ساختارهای دادهای ذکر شده در بالا پاسخ داده شوند. برای مثال، برای مطالعه در مورد این که آیا فشارهای قانونی بیشتر منجر به جرم کمتر میشود را به کمک دادهها مقطعی شهرهای مختلف، دادههای سری زمانی یک شهر خاص و یا دادههای ترکیبی شهرها (که شامل دادههای تعدادی شهر مشخص طی دو سال یا بیشتر است) انجام داد. تصمیمگیری در مورد نوع دادههایی که جمع خواهند شد بستگی به نوع تجزیه و تحلیل ما دارد. برای پاسخ به سوالات مربوط به اشخاص یا خانوارها، اغلب به یک داده مقطعی تکی دسترسی داریم که نوعا از طریق روشهای میدانی به دست میآید. سپس باید پرسید آیا میتوان مجموعه داده نسبتا بزرگی را جمعآوری کرد که به کمک آن تحلیلی معتبر انجام داد؟ برای مثال، فرض کنید میخواهید بدانید آیا خانوارهایی که از طریق صندوق بازنشستگی پسانداز میکنند (این روش پسانداز در برخی ازکشورها دارای مزیت مالیاتی است؛چرا که پسانداز از این طریق مشمول مالیات نمیشود) نسبت به سایر روشها دارای مزیت بیشتری هستند یا خیر. به عبارتی دیگر، آیا پسانداز از این طریق دارای نرخ بازدهی بیشتری است یا نه؟ مجموعههای دادهای زیادی مانند دادههای مالی مصرفکنندگان وجود دارد که حاوی اطلاعاتی در مورد روشهای مختلف پسانداز برای خانوارها است (مبتنی بر آمارگیری نمونهای هستند)، استفاده از این مجموعهها مسایلی به وجود میآورند که شاید مهمترین آنها این است که آیا کنترلهای کافی بر متغیرهایی مانند میزان درآمد، خصوصیات جمعیتشناسی و بدیل سلایق افراد وجود دارد. اگر تنها مجموعه در دسترس همین مجموعه فعلی است، باید اقدامات لازم در مورد آن را انجام داد.
مسایل مشابهی در رابطه با استفاده از دادههای مقطعی بنگاهها، ایالات و نظایر آن وجود دارد. در بیشتر موارد مشخص نیست که آیا می توانید با استفاده از دادههای یک مقطع خاص تحلیل معتبری انجام دهید یا خیر. برای مثال، در بررسی اثر فشارهای قانونی بر وقوع جرم، باید مشکل درونزایی مخارج این فشارها را در مدل تشخیص داده و کنترل کنید. زمانی که از روشهای استاندارد رگرسیونی استفاده میکنید، بسیار مشکل است که از معتبر بودن تحلیلمان مطمئن شوید، صرفنظر از این که چه تعداد اقدام کنترلی را در پیش گرفتهاید. این سالنامهها در اشکال گوناگونی ارایه میشوند. برخی از آنها خصوصاً دادههای سری زمانی (مجموعه دادههای بزرگ) تنها به صورت پرینت شده منتشر میشوند. برای مجموعه دادههای کوچک، وارد کردن دادهها از منابع پرینت شده به کامپیوتر توسط شما، مطمئن و قابل مدیریت خواهد بود. برخی از مواقع مقالاتی به چاپ میرسند که در آنها از مجموعه دادههای کوچک (خصوصا سریهای زمانی) استفاده شده است. این مقالات میتوانند با دادههای تکمیلی به خصوص دادههای سالهای اخیر تکمیل و دوباره انجام شوند.
بسیاری از دادهها نیز به صورت الکترونیکی در دسترس هستند. بسیاری از سایت های نهادهای دولتی اقدام به انتشار نسخه الکترونیک دادههای خود میکنند. اغلب، نویسندگان مقالات تمایل دارند دادههای استفاده شده در مطالعه خود را به صورت الکترونیکی ارایه نمایند. مجموعه دادههای زیادی روی اینترنت در دسترس هستند. به بیانی دیگر، اینترنت یکی از عمومیترین منابع دستیابی به دادههای مورد نیاز است. به این گونه بانکهای اطلاعاتی، بانکهای اطلاعاتی آنلاین[footnoteRef:86] گویند. بسیاری از وبسایتها دادههای اقتصادی یا مرتبط به آن را تولید میکنند. در ادمه مهمترین وبسایتهای ارائه دهنده دادههاق اقتصادی، مالی و اجتماعی در ایران  و خارج از کشور شرح داده شده است. [86: Online databases] 

[bookmark: _Toc10910006][bookmark: _Toc109603298]مهمترین سایتهای خارجی ارائه دهنده آمارهای اقتصادی
در ابتدا مهمترین سایتهای ارائه دهنده آمارهای اقتصادی ارائه میشود و در ادامه نحوه دانلود داده از وبسایت بانک جهانی به عنوان کاملترین مرجع برای دادههای اقتصادی شرح داده خواهد شد.
[bookmark: _Toc10910007][bookmark: _Toc109603299]وبسایت بانک جهانی
دارای گستره‌ی  وسیعی از داده‌های خام آماری برای تمامی کشورهای دنیا در دوره ۱۹۶۰ تاکنون است، لازم به ذکر است این داده‌ها هر ساله جمع‌آوری شده و در یک سی.دی نیز تکثیر می‌شود؛ بنابراین  این بانک اطلاعاتی چه به صورت آنلاین و چه به صورت هارد دیسک قابل استفاده است. بانک جهانی به عنوان کاملترین منبع برا دادههای اقتصادی، برای حدود دویست کشور دنیا و برای هر کشور حدود 1000 متغیر اقتصادی و اجتماعی ارائه میدهد.آدرس سایت بانک جهانی به صورت زیر است:
www.worldbank.org
[bookmark: _Toc10910008][bookmark: _Toc109603300]وبسایت Nation Master
این سایت نیز گستره‌‌ی  وسیعی از آمارها را برای تمامی کشورهای دنیا داراست، ویژگی این وبسایت این است که استفاده کننده میتواند به صورت آنلاین بین متغیرها تحلیلهای همبستگی ساده انجام داده و یا نمودار مربوط به متغیرها را رسم کند. ویژگی خاص مربوط به این وبسایت این است که بسیاری از آمارهای  مربوط به متغیرهای کیفی را گردآوری کرده است. آدرس وبسایت Nation Master به صورت زیر است:
www.nationmaster.com 
[bookmark: _Toc10910009][bookmark: _Toc109603301]سایت کشورهای OECD
سایت مربوط به کشورهای OECD است و دارای اطلاعات اقتصادی اجتماعی دقیقی از این کشورها می‌باشد. بسیاری از دادههای مربوط به این سایت فقط برای کشورهای OECD موجود است و برای سایر کشورها موجود نیست. این سایت مرجعی کامل برای آشنایی با ساختار اقتصادی این کشورها است. آدرس سایت OECD به صورت زیر است:
www.oecd.org
[bookmark: _Toc10910010][bookmark: _Toc109603302]وبسایت UNCTAD
در این وبسایت شما میتوانید اطلاعات بسیار کاملی در زمینه سرمایه‌گذاری خارجی و داخلی، سرمایه ‌‌گذاری مستقیم خارجی  و … برای تمامی کشورهای دنیا  کنید. آدرس سایت UNCTAD به صورت زیر است:
www.unctad.org
[bookmark: _Toc10910011][bookmark: _Toc109603303]وبسایت Penn World Data
در این لینک هم می‌توانی آمار اقتصادی کشورهای دنیا و به ویژه آمریکا را بیابید. آدرس سایت Penn World Data به صورت زیر است:
www.bized.co.uk
[bookmark: _Toc10910012][bookmark: _Toc109603304]وبسایت سازمان جهانی کار ILO
 سازمان جهانی کار، از این لینک می توانید تمامی، آمار و اطلاعات مربوط به نیروی کار و تمام موارد جانبی مربوط به آن را به دست آوردید.
www.ilo.org

[bookmark: _Toc10910013][bookmark: _Toc109603305]سایتهای داخلی
عمده دادههای اقنصادی و مالی در ایران در سایت بانک مرکزی ایران و مرکز آمار ایران موجود است.
[bookmark: _Toc10910014][bookmark: _Toc109603306]بانک مرکزی
fانک مرکزی ايران جهت نيل به اهداف خود که همانا کنترل تورم و توسعه اقتصادی است، اقدام به گردآوری و تهيه طيف وسيعی از آمارهای اقتصادی می‌کند که اين آمارها بهطور عمده شامل انواع شاخص‌های قيمت، گزارش بررسی بودجه خانوار، آمارهای صنعتی، آمار فعاليت‌های ساختمانی و آمار فعاليت‌های خدماتی است. همچنين در اين بخش حسابهای ملی ايران شامل حسابهای ملی فصلی و حسابهای ملی سالانه از سال 1338 تا کنون ارائه شده است. آدرس سایت مرکز آمار ایران نیز www.cbi.ir  است و بخش سری زمانی نیز در آدرس  www.tsd.cbi.ir  قابل دسترس است.
[bookmark: _Toc10910015][bookmark: _Toc109603307]مرکز آمار ایران
ماموریت مرکز آمار ایران، مدیریت تهیه و انتشار آمارهای رسمی کشور و استقرار نظام آمارهای ثبتی‌مبنا با رعایت اصول بنیادین آمارهای رسمی است. آدرس سایت مرکز آمار ایران نیز www.amar.org.ir   است.
[bookmark: _Toc10910016][bookmark: _Toc109603308]آموزش شیوه دانلود داده از بانک مرکزی ایران
برای دانلود داده از بانک اطلاعات سری زمانی بانک مرکزی ایران ابتدا وارد آدرس زیر شوید:
Tsd.cbi.ir
با ورود به آدرس فوق پنجره زیر باز میشود:
[image: ]
از صفحه فوق گزینه ورود را برای بخش فارسی و گزینه Enter را برای بخش لاتین کلیک کنید:
وارد صفحه زیر میشوید:
[image: ]
ابتدا بخشی که مایل به دریافت داده آن هستید مشخص کنید و بر روی + کلیک کنید تا زیربخشها و جزئیات آن باز شود. به عنوان مثال در صورتی که مایل به دریافت داده GDP هستید وارد بخش حساب های ملی به صورت زیر میشوید:
[image: ]
 در این بخش حسابهای ملی به سال پایه برای سال 1376، 1383 و سال 1390 موجود میباشد. وارد یک بخش دلخواه، بعنوان مثال بخش سال پایه 1390 شوید. برای این کار گزینه + کنار آن را کلیک کنید:
[image: ]
[image: ]عناوینی که با تصویر     آغاز میشوند، دارای مقدار بوده و قابل دانلود هستند. با کلیک روی هر یک از موارد، عنوان مربوطه به لیست عناوین انتخاب شده در این پنجره افزوده میشود. 
[image: ]
پس از اينکه عناوين موردنظر خود را انتخاب کرديد، دکمه "نمایش گزارش" را از پنجره "عناوين برگزيده " انتخاب کنيد. به عنوان نمونه به شکل زیر دقت کنيد. در پنجره " عناوين برگزيده " سه عنوان برگزيده شده‌اند . با فشردن دکمه "نمایش گزارش" که زير اين عناوين قرار دارد صفحه جدیدی مشابه شکل زیر باز می‌شود:
[image: ]
در اين صفحه تواتر و بازه سالانه‌ای مورد نظر انتخاب میشود. اين انتخاب باعث می‌شود اطلاعات آماری عناوين انتخاب شده تنها در تواتر و دوره زمانی موردنظر شما ظاهر شوند. اکنون با انتخاب هر یک از دکمه های "گزارش HTML" ، "گزارش Excel" و یا "نمودار"، گزارش را در قالب مورد نظر خود دریافت خواهید کرد .برخی عناوین انتخاب شده، به جای تاریخ خورشیدی بر اساس تاریخ میلادی مقدارگذاری شدهاند، از اینرو در صورتی که ترکیبی از عناوین خورشیدی و میلادی را برگزیده باشید، با انتخاب هر یک از دکمه های زیر دو صفحه برای نمایش گزارش در تاریخهای خورشیدی و میلادی باز میشوند. به عنوان مثال با کلیک بر روی "نمودار" روند متغیرهای انتخاب شده در دوره مورد نظر ظاهر میشود
[bookmark: search]جستجوی عناوین اطلاعاتی
 با کلیک دکمه "جستجو" جعبه کوچکی برای وارد کردن عبارت مورد جستجوی کاربر پدیدار میشود. عبارت مورد نظر خود را وارد کرده و دکمه جستجو را انتخاب کنید. همه عناوینی که عبارت مورد نظر شما در آنها یافت میشود در کادر سمت راست به ترتیب حروف الفبا لیست میشوند. پایین هر عنوان شاخههایی که عنوان مزبور از آنها مشتق شده درج شدهاند تا کاربر از جایگاه دقیق هر عنوان در ساختار اطلاعات آگاهی یابد. در صورتی که عنوانی حاوی مقدار عددی باشد علاوه بر اینکه سمت راست آن تصویر پیکانی قرمز رنگ ظاهر میشود، روبهروی عنوان دکمه "انتخاب" درج میشود که با انتخاب این دکمه، عنوان مربوطه به لیست پنجره "عناوین برگزیده" افزوده میشود (پنجره پائین سمت چپ در شکل زیر) همه عناوین لیست شده دارای دکمه "فراداده" هستند، که با انتخاب این دکمه فراداده مرتبط با موضوع در پنجره فراداده نمایش داده میشود (پنجره بالا سمت چپ در شکل زیر). در صورتی که نتیجه جستجو بیشتر از 10 مورد باشد بقیه عناوین در صفحات بعد نمایش داده میشوند، دکمه "صفحه بعد" در انتهای کادر سمت راست، دیگر صفحات دستاورد جستجو را نمایش میدهد. سمت چپ دکمه "جستجو" پیوند "جستجوی پیشرفته" قرار دارد که برای دریافت آگاهی بیشتر به بخش"جستجوی پیشرفته عناوین اطلاعاتی" مراجعه کنید (مطابق شکل زیر).
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[bookmark: advsearch][bookmark: _Toc10910017][bookmark: _Toc109603309]جستجوی پیشرفته عناوین اطلاعات
با کلیک دکمه "جستجو" جعبه کوچکی برای وارد کردن عبارت مورد جستجوی کاربر پدیدار میشود (شکل زیر). سمت چپ دکمه "جستجو" پیوند "جستجوی پیشرفته" قرار دارد که با انتخاب آن فرم جستجوی پیشرفته باز مطابق شکل زیر میشود. این فرم به شما اجازه میدهد عناوین مورد نظر خود را دقیقتر مورد جستجو قرار دهید. لیست "تواتر" و لیستهای "سال شروع" به کاربر امکان میدهد که جستجو را تنها در عناوینی انجام دهد که تواتری مشخص دارند و یا سال شروع آمارگیری آنها در بازه خاصی قرار دارد. لیست دیگری وجود دارد که نحوه جستجوی کلمات درج شده را مشخص میکند. این لیست شامل این موارد است: "عین عبارت"، "هر یک از کلمات" و "همه کلمات". اگر گزینه "عین عبارت" انتخاب شود نتیجه جستجو مشابه جستجوی ساده خواهد بود. در صورتی که مورد "هر یک از کلمات" را انتخاب کنید، همه عناوینی که حداقل یکی از کلمات مورد نظر شما را دارا باشند لیست میشوند. به شکل زیر نگاه کنید:
[image: ]
 در این مورد کاربر عبارت "پول بانک" را در جعبه جستجو وارد کرده و گزینه "هر یک از کلمات" را برگزیده است. با فشردن دکمه جستجو همه عناوینی که یا کلمه "پول" و یا "بانک" و یا هر دو را دارند  لیست شدهاند. در صورت انتخاب گزینه "همه کلمات" تنها عناوینی لیست میشوند که همه کلمات مورد نظر شما در ساختار آنها موجود باشد. مثلاً در این مورد عناوینی که هم کلمه "پول" و هم کلمه "بانک" در ساختار آنها وجود دارد بدون در نظر کرفتن ترتیب یا جایگاه این کلمات لیست میشوند. پس از فشردن دکمه "جستجو" همه عناوین یافت شده در کادر سمت راست به ترتیب حروف الفبا لیست میشوند. پایین هر عنوان شاخههایی که عنوان مزبور از آنها مشتق شده درج شدهاند تا کاربر از جایگاه دقیق هر عنوان در ساختار اطلاعات آگاهی یابد. در صورتی که عنوانی حاوی مقدار عددی باشد علاوه بر اینکه سمت راست آن تصویر [image: http://tsd.cbi.ir/Images/Val5.gif] ظاهر میشود، روبهروی عنوان دکمه "انتخاب" درج میشود که با انتخاب این دکمه، عنوان مربوطه به لیست پنجره "عناوین برگزیده" افزوده میشود (پنجره پائین سمت چپ در شکل بالا). همه عناوین لیست شده دارای دکمه "فراداده" هستند، که با انتخاب این دکمه فراداده مرتبط با موضوع در پنجره فراداده نمایش داده میشود (پنجره بالا سمت چپ در شکل بالا). در صورتی که نتیجه جستجو بیشتر از 10 مورد باشد بقیه عناوین در صفحات بعد نمایش داده میشوند، دکمه "صفحه بعد" در انتهای کادر سمت راست، دیگر صفحات دستاورد جستجو را نمایش میدهد. سمت چپ دکمه "جستجو" پیوند "جستجوی پیشرفته" قرار دارد که برای دریافت آگاهی بیشتر به بخش" جستجوی پیشرفته عناوین اطلاعاتی "مراجعه کنید
[bookmark: _Toc10910018][bookmark: _Toc109603310]نحوه دانلود داده از بانک جهانی
در این بخش نحوه دانلود داده از بانک جهانی به عنوان کاملترین منبع ارائه دهنده دادههای اقتصادی به صورت تصویری و مرحله به مرحله شرح داده خواهد شد. 
ابتدا از طریق آدرس زیر وارد وبسایت بانک جهانی شوید:
www.data.worldbank.org
پنجرهای به شکل زیر باز میشود:

[image: ]
مسیرهای مختلفی برای دانلود داده در این قسمت براساس، کشور، موضوع و یا شاخص مورد نظر وجود دارد. در ادامه سادهترین راه و در عین حال کاملترین مسیر که امکان دسترسی به کلیه کشورها و متغیرها فراهم باشد توضیح داده میشود:
بر روی World Development Indicators به صورت زیر کلیک کنید:
[image: ]
پنجره زیر باز میشود که باید کشور (کشورهای) مورد نظر یا متغیر (متغیرهای مورد نظر) و دوره زمانی مورد نیاز انتخاب شود:




[image: ]

[bookmark: _Toc10910019][bookmark: _Toc109603311]در بخش Country
در این بخش کشور و یا کشورهای مورد نیاز برای مطالعه را با زدن تیک انتخاب کنید.
[bookmark: _Toc10910020][bookmark: _Toc109603312]در بخش Series 
متغیرهای مورد نظر (که در اینجا حدود 1000 متغیر برای هر کشور موجود است) را انتخاب کنید
[bookmark: _Toc10910021][bookmark: _Toc109603313]در بخش Time
 دوره زمانی مورد مطالعه را انتخاب را انتخاب کنید.
پس از تکمیل بخشهای فوق، در همین پنجره گزینه Apply Changes را مطابق شکل زیر کلیک کنید:
[image: ]
پس از طی مسیر بالا، پنجره زیر باز میشود:
[image: ]
پس از طی مراحل بالا برای دانلود دادههای انتخاب شده، کافی است بر روی گزینه Download در بخش بالا و سمت راست صفحه، به صورت زیر کلیک کنید:
[image: ]
با انتخاب گزینه اول، فایل داده را بهصورت اکسل دریافت کنید.
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System: SY5_TLOG. Workile: G_COST:

_k=c(1)+c(2"Tog(p_kip_m)+(3)"log(p_Up_m)+c(4)og(p_efp_m)
c_t=c(5)+¢(3"T0g(p_Kip_m)+<()"log(p_Lp_my+c(7)"log(o_eip_m)
_e=c(8)+c(4)"loa(p_kip_m)+c(log(p_lip_m)+c(3)log(p_elp_m)
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System: SYS_TLOG

Estimation Method: Full Information Maximum Likelihood (BFGS / Marquardt

steps)
Date: 0310/15_Time: 22:09
Sample: 1947 1971
Included observations: 25
Total system (balanced) observations 75
Convergence achieved after 38 iterations
Coefficient covariance computed using outer product of gradients

Coefficient ~ Std. Error  z-Statistic  Prob.
c(1) 0057022 0003306 1724913  0.0000
c(@) 0029742 0012583 2363697 00181
c(3) -0.000369 0011205  -0.032971 09737
c(4) 0010228 0006027 -1.697176 00897
c(s) 0253398 0005050  50.17733  0.0000
c(e) 0075427 0015483 4871616  0.0000
() 0004414 0009141  -0.462900 06292
c(e) 0044286 0003349 1322339 0.0000
cis) 0018767 0014834 1260009 02077
Log likelihood 344.5916 Schwarz criterion -26.40853
Avg. log likelihood 4.594555 Hannan-Quinn criter. -26.72563
Akaike info criterion 26,8473

Determinant residual covariance 244E-16
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System: SYSTEMO1
Estimation Method: ARCH Maximum Likelihood (BFGS / Marquardt steps)
Covariance specification: Diagonal VECH

Date: 03/10/15 Time: 22:15

Sample: 12/31/1979 12/25/2000

Inclucied observations: 1096

Total system (balanced) observations 3288

Presamplo covariance: backcast (parameter ~0.7)

Convergence achieved after 68 iterations

Cosflicient covariance computed using outer product of gradients

Cosficient  Std. Eror  z Statisic _Prob.

o 0000855 0000446 -1.936740 00528
@) 543E:05 0000454  0.19510 03049
c@) 349E-05 0000378 0002282 0265

Variance Equation Coefiicients

o) 649E-05  110E-06 5919901 00000
c(s) 364506 967E07 3759945 00002
6 264E-06  739E07 3575569  0.0003
) 104605  228E06 4550943  0.0000
ce) BOIE-06  162E06 4972743  0.0000
) 13905 249E06 5500122  0.0000

c(i0) 0059566 0007833  7.546435 00000

e 0052100 0007282  7.154681 00000

(i2) 0046822 000825 5668999  0.0000

c(13) 0058630 0007199 8144178 00000

c(14) 0067051 0007508 8931132 00000

c(is) 0112734 0008091 1393397 00000

c(ig) 0917973 0010867 8447647  0.0000

c(17) 0928844 0009850 9420352 00000

c(ig) 0924802 0010562 8755899 00000

(19 0908492 0011498  79.01305  0.0000

ciz0) 0886249 0011892 7452704 00000

cei) 0829154 0012741 6507734 00000
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Covariance specification: Diagonal VECH
GARCH = M + A1."RESID(-1)" RESID(-1)’ + B1-GARCH(-1)
M is an indefinite matrix
A1 is an indefinite matrix
8115 an indefinite matrix*

Transformed Variance Coefficients

Coefficient ~ Std. Emor  zStatistic  Prob,
M1, 1) 6.49E-06  1.10E-06 5919903 00000
M(1,2) 364E-06 967607 3750946 00002
M(1,3) 2.64E-06  7.39E-07 -3.575568  0.0003
M22) 1.04E:05  2.28E-06 4550942  0.0000
M2,3) B.03E-06  162E-06 -4.972744 00000
M@.3) 1.39E-05  249E-06 5590125  0.0000
A1(1,1) 0.059566 0007893 7546440  0.0000
A1(1,2) 0.052100 0007282  7.154665 00000
A1(1.3) 0.046822 0008259 5669004 00000
Al(2.2) 0.058630 0007199 8144180  0.0000
A123) 0.067051 0007508 8931139 00000
A13,3) 0.11273¢ 0008091 1393396 00000
Bi(1,1) 0917973 0010887 8447655 00000
B1(1,2) 0.928844 0009880 9420361  0.0000
B1(1,3) 0.924802 0010562 8755915  0.0000
B12.2) 0908492 0011498 7901313 00000
B1(2.3) 0886249 0011892 7452720 00000
81(3,3) 0.82915¢ 0012741 6507757 00000

* Coefficient marix is not PSD.




image72.png
M(1,1) + A1(11)"RESIDT(1)°2 + B1(1,1)"GARCH1 (1)
[GARCH2 = M(2,2) + A1(2.27RESID2(1)/2 + B1(2.27GARCH2(1)
[GARCH3 = M(3,3) + A1(3,3RESIDI(1)"2 + B1(33"GARCH3(1)

COVI_2=M(1,2) + A1(1,2)"RESID1 (1)'RESID2(-1) + BI(1

[COVI_3= M(1,3) + A1(1 3 RESID1¢1RESIDIC1) + B1(1,37COVI_3¢-1)

COV2_3=M(2.3) A1 (2.3 RESID2(1RESID3(1) + B1(2,3°C0V2_3¢1)
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s LT St

Estimation Method: ARCH Maximum Likelihood (BFGS / Marquard steps)
Covariance specification: Constant Conditional Correlation

Date: 0310/15_Time: 22:29
Sample: 12/31/1979 12/25/2000
Included observations: 1096
Total system (balanced) observations 3288
Presample covariance: backcast (parameter =0.7)
Convergence achieved after 48 iterations
Coefficient covariance computed using outer product of gradients

Coefficient  Std. Error  z-Statistic  Prob.
(1) -0.000804  0.000450  -1.768285 00737
c) -0.000232  0.000467  -0.497008 06192
c(3) 856E-05 0000377 0226828 08206
Variance Equation Coefficients
c(4) 584E-06  130E-06 4482923  0.0000
c(s) 0062911 0010085 ~ 6238135  0.0000
c(e) 0916958 0013613 6735993  0.0000
() 489E-05  172E-05 2836869 00046
c®) 0063178 0012983 4864468  0.0000
o) 0772214 0064005 1206496  0.0000
c(10) 147605  311E-06 4735844 0.0000
cli1) 0104348 0009262 1126665  0.0000
c(12) 0828535 0017935  46.19303  0.0000
c(13) 0571323 0018238 3132550  0.0000
ci4) 0403219 0023634  -17.06082 00000
C(15) 0677329 0.014588  -46.43001 00000
Log likelihood 9593.125 Schwarz criterion -17.40991
Avg. log likelihood 2917617 Hannan-Quinn crite. -17.45244

Akaike info criterion

-17.47833
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Covariance spedification: Constant Conditional Correlation

GARCH(|

cov(i

R0}y @SQRT(GARCH() GARCH())

M) + A1) RESID()(-1)"2 + B1()"GARCH()(-1)

Transformed Variance Coefficients

Coefficient ~ Std. Emor  zStatistic  Prob,
m(1) 5.84E-06  1.00E-06 4482923 00000
A1) 0062911 0010085 6238137  0.0000
B1(1) 0916958 0013613  67.35994  0.0000
M@ 489E-05 172605 2836869 00046
Al(2) 0063178 0012988  4.864469  0.0000
B1(2) 0772214 0064005 1206496  0.0000
M) 147605  311E-06 4735844 00000
A3 0104348 0009262 1126665 00000
B1(3) 0.828535 0017936  46.19308  0.0000
R(1.2) 0571323 0018238 3132550  0.0000
R(13) 0403219 0023634 1706082  0.0000
R(23) 0677329 0014583 -46.43002  0.0000
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CINEACHE VI Y
Method: Panel Least Squares

Date: 0823106 Time: 14:29

Sample: 1508

Periods included: 30

Gross-sections included: 92

Total panel (unbalanced) observations: 506

Coefficient St Error _ :Stal Prob.
3 8993272 0134738 6674632  0.0000
CRIM 0625400 0104012 6012746 00000
CHAS 0452414 0298531 1515467  0.1304
NOX 0558938 0135011 4139949 0.0000
AM 0927201 0122470 7570833 00000
AGE 1406955 0486034 2804767 00040
ois 0801437 0711727 1126045 02608
8 0663405 0103222 6426958  0.0000
LSTAT 2453027 0255633 9505692 00000
Effects Specifcation

Cross-section fixed (dummy variables)
Resquared 0918370 Meandependentvar 9942268
Adjusted R-squared  0:898465  S.D. dependent var 0408758
S.E.of regression 0130249 Akaike info ciiterion -1.063668
Sumsquaredresid 6887683  Schwarz criterion 0.228384
Log likelihood 9.1080  Hannan-Quinn criter. 0736071
Fstatistic 4613805 Durbin-Watson stat 1999986

Prob(F statstic) 0000000
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Dependent Variable: MV
Method: Panel EGLS (Cross-section random effects)
Date: 0823106 Time: 14:34

Sample: 1508

Periods included: 30

Gross-sections included: 92

Total panel (unbalanced) observations: 506

Wallace and Hussain estimator of component variances

Coefficient ~ S1d. Exror ic  Prob.
c 9684427 0207691 4662904  0.0000
CAIM 0737616 0108966 6769233 00000
Y 0072190 0684633 0105443 09161
INDUS. 0164948 0426376 0386860  0.6990
CcHAS 0056459 0304025 -0.185703 08528
NOX 0584667 0120825 4503496 00000
AM 0908064  0.123724 7339410 00000
AGE 0871415 0487161 1788760 00743
oIS 1423611 0462761 3076343 00022
RAD 0961362 0280649  3.425493 00007
TAX 0376874 0186695 2018658  0.0441
PTRATIO 2951420 0956355 3079674 00022
B8 0565195 0106121 5325958  0.0000
LSTAT 2809084 024300 1162891 00000
Effects Specification

sD. Aho

Gross-section random 0126983 04496

diosyncratic random 0140499 05504
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Dependent Variable: LSCRAP
Method: Panel Least Squares.
Date: 08/1800 Time: 12:03

Sample: 1987 1989

Periods included: 3

Cross sectons induded: 54

Total panel (balanced) observations: 162
White period standard errors & covariance (no d. . correcton)
WARNING: estimated coefficient covariance matrix s of reduced rank

Variable Coeffident  Sw. Eror  tStaisic Prob.
c 0507434 0062489 9560565 00000
s 0080216 0095719 -0.838033 04039
D89 0247203 0192514 1284075 02020
GRANT 0252315 0140320 1798022 00751
GRANT_1 0421589 0276335 1525648 0.1301

Eflects Specifcation

Cross section fixed (dummy variables)

Resquared 0.927572
Adusted Resquared  0.887876
SE. of regression 0.497744
Sumsquaredresid  25.76593
Loglikelinood -80.94602
Fstistic 23.36680

ProbiF statstc) 0.000000

Mean dependent var
.D. dependent var
Awaike info crierion
Schwarz criterion
Hannan-Quinn ciiter.
Durbin-Watson sat

0390681
1486471

1715383
2820819
2161207
1986983
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Dependent Variable: D(LSCRAP)
Method: Panel Least Squares

Date: 08/1809 Time: 12:05

‘Sample (adjusted): 1988 1989

Periods included: 2

Cross sections induded: 54

Total panel (balanced) obsenvations: 108

White period standard errors & covariance (no d.{. correction)

Variable Coeffient ~ Sul. Error  tStatistic  Prob.
c -0.090607 0088082 -1.028671 03060
D89 -0096208 0111002 -0.866721 03881
D(GRANT) ‘0222781 0128580 -1.732624 00861
DGRANT 1) ‘0351246 0264662 -1.327147  0.1874
Rsquared 0036518 Meandependentvar  -0221132
Adjusted Rsquared  0.008725 .. dependent var 0579248
SE. of regression 0576716 Akaike nfo criterion 1773399
Sum squared resid 34.59049  Schwarz criterion 1872737
Loglikelihood 91.76352 Hannan-Quinn citer. 1813677
Fstatistic 1.313929  Durbin-Watson stat 148132
Prob(F statistc) 0.273884
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Dependent Variable: RESIDO1
Method: Panel Least Squares

Date: 08/1809 Time: 12:11

Sample (adjusted): 1989 1989

Periods included: 1

Cross sections induded: 54

Total panel (balanced) observations: 54

Variable Coefiicent ~ Std. Error  tStatistic  Prob.
RESIDO1(-1) 0236906 0133357 1776481 00814
Resquared 0056199 Meandependentvar  617E18
Adjusted R-squared  0.056199 S.D. dependent var 0571061
SE. of regression 0.554782  Akaike info criterion 1677863
Sum squared resid 16.31252  Schwarz criterion 1714696
Log likelihood 4430230 Hannan-Quinn ciiter. 162068

Durbin-Watson stat ~ 0.000000
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Dependent Variable: D(LUCLMS)

Method: Panel Two-Stage Least Squares

Date: 08/23/06 Time: 15:52
Sample (adjusted): 1983 1988
Periods included: 6
Cross-sections included: 22

Total panel (balanced) observations: 132
Instrument ist: C D(LUCLMS(2)) D(E2)

Coefficient  Std. Error  t-Statistic  Prob.
c 0201654 0040473 4982442 0.0000
D(LUCLMS(-1)) 0164699 0288444 0570992  0.5690
D(EZ) 0218702 0106141 2060493  0.0414

Effects Specification
Period fixed (dummy variables)

R-squared 0280533 Meandependentvar  0.235098
Adjusted R-squared 0239918 S.D. dependent var 0267204
S.E. of regression 0232956 Sum squared resid 6.729300
Fstatistic 9223709 Durbin-Watson stat 2857769
Prob(F-statistic) 0000000 Second-Stage SSR 6.150596

Instument rank 8000000
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£4 Series: CO2 Workfile: UNTITLED:Untitled\ - B x

[Viw[Proc]ObiectProperties] [Pt  Name | Frecz [ sampie [ Gemesmeet | Grap]Stts
Panel Unt Root Test on CO2

Panel unit oot test: Summary

Series: CO2

Date: 04/11/14_Time: 06:07

‘Sample: 1990 2010

Exogenous variables: Individual effects

User-specified lags: 1

Newey-West automatic bandwicth selection and Bartettkernel

Cross-
Method Statistic__Prob** _sections __Obs.
'Null: Unit 1001 (355Umes common unit oot process)

Levin, Lin & Chut 065132 07426 8 139
"Null: Unit oot (assumes individual unit root process)

Im,Pesaran and Shin W-stat  -064204 02604 8 139
ADF - Fisher Chi-square 231245 01104 8 139
PP - Fisher Chi-square 207149 01897 8 148

* Probabilites for Fisher tests are computed using an asymptotic Chi
~square distribution. All ther tests assume asymptotic normality.
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£4 Series: CO2 Workfile: UNTITLED:Untitled\ - B x

[View[Proc]ObiectProperties] [Pt  Name | reeze [ sample [ Gemesmeet [ Grap]Stts
Panel Unit Root Test on D(CO2)

Panel unit oot test: Summary

Series: D(CO2)

Date: 04/11/14_Time: 06:15

‘Sample: 1990 2010

Exogenous variables: Individual effects

User-specified lags: 1

Newey-West automatic bandwicth selection and Bartettkernel

Cross-
Method Statistic__Prob** _sections __Obs.
'Null: Unil 1001 (355Umes common unit 100t process)

Levin, Lin & Chut 649646 00000 8 131
Null: Unit oot (assumes individual unit root process)

Im,Pesaran and Shin W-stat  -575644 00000 8 131
ADF - Fisher Chi-square 641504 00000 8 131
PP - Fisher Chi-square 976766 00000 8 139

* Probabilites for Fisher tests are computed using an asymptotic Chi
~square distribution. All ther tests assume asymptotic normality.
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Pedroni Residual Cointegration Test
Series: IVM MM

Date: 12/13/06 Time: 11:43

Sample: 1968Mo1 1995M12

Included observations: 2688
Cross-sections included: 8

Null Hypothesis: No cointegration

‘Trend assumption: No deterministic trend

Lag selection: Automatic SIC with a max lag of 16
Newey-West bandwidth selection with Bartlett
kernel

Alternative hypothesis: common AR coefs. (within-dimension)

Weighted
st Pr tistic P
Panel v-Statistic 4219500 00001  4.119485 00001
Panel tho-Statistic 0400152 03682 2543473  0.0157
Panel PP-Statistic 0671083 03185 -1.254923 0815
Panel ADF-Statistic 0216806 03897 0172158 03931
Alternative hypothesis: individual AR coefs. (between-dimension)
Statistic _Prob,
Group rho-Statistic 1.776207  0.0824
Group PP-Statistic 0824320 02840

Group ADF-Statistic 0538943 03450
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Cross section specific results

Phillips-Peron results (non-parametric)

CrossID __AR(1) _ Variance HAC _Bandwidth  Obs
AUT 0959 5405716  46699.67 2300 321
BUS 0959 9838747 98024.05 700 321
CoN 0966 1440929  125609.0 400 321
csT 0933 5795150 4687809 600 321
DEP 0908 8967004 5729648 700 328
HOA 0941 1467027 1650855 600 321
MAE 0975 2996615, 2018633 300 321
Mis 0991  2775062.  3950850. 700 321

Augmented Dickey-Fuller results (parametric)

CrossID___AR(1) Variance lag  Maxlag  Obs
AUT 0983  48285.07 5 16 316
BUS 0971 95843.74 1 16 320
COoN 0966 1440929 0 32
csT 0949 556149.1 1 16 320
DEP 0974 6473405 2 16 319
HOA 0941 1467027 o 16 a2
MAE 0976 2459970, 6 16 315
mIS 0977 2605045, 3 16 318
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Dependent Variable: DLOG(CONS)
Method: ARDL

Date: 03/11/15 Time: 09:44
Sample: 1962 1993

Included observations: 767
Dependent lags: 1 (Fixed)

Dynamic regressors (1 lag, fixed): LOG(INF) LOG(ING)

Fixed regressors: C

Variable Coefficient~ Std. Error  t-Statistic  Prob.”
Long Run Equation
LOG(NF) ‘0464856 0056705 8.197798 00000
LOG(INC) 0904398 0008687 1041114 0.0000
‘Short Run Equation
CONTEQO! ‘0199949 0032126 6223894 00000
D(NF) 0018883 0025371 0.744295 04570
DLOG(INC) 0327691 0057425 5706388  0.0000
c 0154571 0021679  7.130068  0.0000
Log likelinood 2327.084
“Note: p-values and any subsequent tests do not account for model

selection.
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Descriptive Statistics for FRD
Categorized by values of @CROSSID

Date: 02/05/13 Time: 15:43

Sample (adjusted): 1971 1990

Included observations: 440 after adjustments

@CROSSID| Moan __ Std.Dev. __ Obs.
1 0823050 0.329523 20
2 0857000  0.169526 20
3 0893250  0.153560 20
4 0870250 0170139 20
5 0913400  0.106301 20
6 0839050  0.184148 20
7 0865650  0.174743 20
8 0860900  0.205281 20
9 0844000  0.226664 20
10 0882750  0.147099 20
11 0940250  0.199533 20
12 0876000 0232249 20
13 0973600  0.124876 20
1 0781800  0.238805 20
15 0820250  0.132656 20
16 0834050  0.167274 20
17 0863000 0247619 20
18 0799700 0.185269 20
19 0662100  0.160519 20
20 0853350  0.116893 20
21 0854800  0.198757 20
22 0865100  0.184872 20
Al 0853332 0195387 440
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Test for Equality of Means of F
Categorized by values of FN
Date: 08/22/06 Time: 17:11
Sample: 1935 1954

Included observations: 200

Method df Value  Probabilty
Anova F-test (9.190) 2934251 00000
Welch F-tost* (9.712051) 2593607 00000
*Test allows for unequal cell variances

Analysis of Variance

Source of Variation df SumofSq.  MeanSa.
Botween 9 321E«08 35640052
Within 190 23077815 1214622
Total 199 344Es08 1727831
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Panel Covariance Analyss: Ordinary
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‘Centered Long.run Covariance (Bartitt kernel, Newey-West fixed bai

LCARPCAP | LGASPCAR
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AcelanlBond Seral Correlstion Test

Cross-sedion fxed (Gummy varnabies)

Resquared 0973366 Mean dependentvar 4296242
AdustedRsquared 0971706 SD. dependentvar 0548907
SE dlregression 0082330 Axaikeinfociterion 1867450
Sumsquaredresia 2736491 Schwar citerion 1631979
Loglikelinood 3403340 Hannan-Quinn crter. 1773645

Fstatistic 5865556 Durbin-Watson stat 0326578
Pron(F-statistic) 0.000000
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[View]Proc]Obiect] [Print Name]Feese] [Estimate Foecastsat Resis]

Residual Cross-Section Dependence Test
Null hypothesis: No cross-section dependence (correlation) in residuals
Equation: GAS

Periogs included: 19

Cross-sections included: 18

Total panel obsenvations: 342

Cross-section effects were removed during estimation

Test Statistic df  Prob.

Breusch-Pagan LI 1027.135)
Scaled Breusch-Pagan LI 48.94200

Bias-corrected scaled LM 48.44200
Pesaran CD 3249563
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Arellano-Bond Serial Correlation Test
Equation: Untitled

Date: 02/04/13 Time: 23:58
Sample: 1976 1984

Included observations: 611

Test order m-Statistic o SE(tho)

Prob.
AR(1) 2427825 -2.106427 0.867619  0.0152
AR(2) -0.332535 -0.075912  0.228281 0.7395





image125.png
3
Gighatobgun
‘Economic Research and Policy Department

[(BOMOIII® Time Series Database





image6.png
E(e) =0, B(ese,) = E,.and Blee) = 0 for i




image126.png
oanais
olawos
SiLaidl ilo; SWSw wleMbl U

el 5 Ll 51 5 Gdgs sl ool Slpuissn slol » Jowiio
US 0l 1 09Ma sk 3,90 wsules WSlpurw i>lo.cul WYL ilss
5 slgs Aosane Ulullz 5550 Sl OLIsl LS 3 Salasl Sl
Clowogi ik v 9ukS w53 slol O3S siio bye @10
0D 3 Lyl 3,80 s bl S g i B YERAS 5 15,90
5 3185 3 Sl 2alss 0 0y 5D 33 ol 018Lise L6 0
ke o5 53 15,50 Sloxsdgs 3 (Nl ie 3155 Gys0 ) lal 15l
38 1515 85 Cuwl o1 >l S| WS A Glolu -iules 01BLiss |,
BUS - Sguisine 031> Gliini 011585 (r3lis 0,5 5> Dl 51 u pusio

GuissS A8 5 0301 5la Sl g Sl + 0 b @S uslic
olic o @ abgsye Olgic olgo 5| S s Sgy Sl b xitwa
SIS Ll oloily Sy 59 035381 0,31 ol 53 04 sl
S





image127.png
PRN
olawos
SiLaidl ilo; SWSw wleMbl U

el 5 Ll 51 5 Gdgs sl ool Slpuissn slol » Jowiio
US 0l 1 09Ma sk 3,90 wsules WSlpurw i>lo.cul WYL ilss
5 slgs Aosane Ulullz 5550 Sl OLIsl LS 3 Salasl Sl
Clowogi ik v 9ukS w53 slol O3S siio bye @10
0D 3 Lyl 3,80 s bl S g i B YERAS 5 15,90
5 3185 3 Sl 2alss 0 0y 5D 33 ol 018Lise L6 0
ke o5 53 15,50 Sloxsdgs 3 (Nl ie 3155 Gys0 ) lal 15l
38 1515 85 Cuwl o1 >l S| WS A Glolu -iules 01BLiss |,
BUS - Sguisine 031> Gliini 011585 (r3lis 0,5 5> Dl 51 u pusio

GuissS A8 5 0301 5la Sl g Sl + 0 b @S uslic
olic o @ abgsye Olgic olgo 5| S s Sgy Sl b xitwa
SIS Gl yiinas (suboily Sl 3aiian 039391 0530 ol 5> 00 sl
S

S oL e

s o sy

Spalas e

el gal

LR § il S3205

ESRETSPI |
(1376=100) sl Ul i 1 L0 SID s
(1383=100) sl Ul i 1 Lo SID s
(1390=100) sl Ul i 1 L0 SID s





image128.png
PRN
olawos
SiLaidl ilo; SWSw wleMbl U

b Bl 5 Lo Sl 5 Qg wuslse oSy Slpaias lol s Jowsiao
S 0,131 1 0gUE b 3,90 wuloy WSlpsrw inlo.Cowl WYL ilgs
5 Bslgs Aogane lullg S3550 b GLIS 5D 5 SLaisl Skl
Clasiogs il 50 9ukS Bl 53 ol OAS isian baiye 8310
020D 53 5 3,90 suRin Ll Sl Y R0 5D YERES 5> S350
5 ilgs £ s nlgi 50 0ymir 5D > sl 03DLie BB 0,7y
i JogaS 3 55950 Do 9 (ol 1516 3155 Gy ,3) Hlol i5lo
33 1515 A5 Cowl o >b S| S W Blobw wles 01BLis I

Ol . 35uircho 0313 Ui 0235 o9 D 3> G 51 Uik sa5k0

i3S B g 0301 Jlase bl cxiguin Slel < 03 b aS swslic
olic o @ abgsyo Olgic olgo 5| S s gy Sl b xitwa
SIS Gl yiinas (suboily Sl 3aiian 039391 0530 ol 5> 00 sl
S

03205 Cumio ks
S0 3 Ol ik
i Joo s
Si3LS iy
sslo sal
IS0 5 o] S
sl I8 Ll
(1376=100) aly UL st 2 510 1B o £
(Sl S Ciad 2).53Lal I Cullad v 1 Lo (a5l (s0133) s
[1376 Ul ol S o ) 531l SIB e i 1 50 a5t (30133) g5
(Sl 518 Ciad @) slo pallsl ausd-
(1376 ULy ol SIB a0 ) 5o LIS 25
1376 Ul b S1pi0.5 @ alls aulo (35290
S 515205 @ allS loy 539780
GFS aluslys Cgs 5010 SUylol
(1383=100) aly Ulaw st 1 510 SIB b





image129.png




image130.png
1l SISl Sl a3 B 3190 SUD s oy oy 035391 Olinass o o oad English (sLol waio

Pekiann 528 Slglo pall> 10lgic
WV il
1383 :50 Ul
S8S S 5,15 QUlys S Caldy axde Uil 5lol islo

olawos

Slpin puiiass u8 5B Ao L onsl ke piians st S Sl alls
S Consl (55UIo pains 8 llla, OBALS 1Ig5 @) > (sllo 5L oS
loxs 5 VIS il Guasd 5 5 39 o calay S3Lasl SlB1>ls Sk

s g 35 U 5 s aigs caulys 1 Ygasa a5 Slllo Egi lanS cna
s 3 5 o @8Lol A5 s @ 13555 np £23 loss 5 AU SBaiS

clgiyoste | canss gwmur gste |

3o padiens 8 Slgillo alls
[ S 108 @) S aS! S1B codled om0 LIS () 5L 1 5

a0 )| 2 anio e o)

st 52 | [ gisS pietes

Shalas e
actas sgal

e 5 il 55305

RET AP |

(1376=100) sl s s 1 L0 S s

(51 1B 0.8 R) SIS S1B Codled ons> 3 Lo LIS (a5l) 1 £
LS oa 29581 uisl+

Caai oaf 29381 gl <

Oslemo 3 il 09 229581 il

o 05,8 S 028591 G

b 3305 <

EOSECERPENPrEeS

s Gy s 08 s 3T LIS g

25 5 258 Jolge 200y alls

Baiid st Slllo S <

s 0 & Lo LIS (301)) g

s 1B oy St <

o i

0 ULl 1B 105 @)L S8 e wans 3 510 IS (10133 55
(S SIB 08 2) ko L5l a5

(1390 Ul S o @) s il i

1390 U b 1518205 & LallS loes 538350





image131.png
S i 15 395 ki 3,90 1 3 o 05 el

[ (2008/09) 1387 | uaw v [0 (1978/79) 1357 | ot st [¥ i | tss

s ] [ Excelou® ] [ HIMLGUE





image132.png
AL Sl | e 390 B o s g | s o 2l | Enghsh

s

s
530018l ilo; S oMbl S

(U15429) Ll 93,5 i & s 3 (osic!
e o 3 gy Shosge closs o3l ol + 1
<t ol N ol L Sl a5 i )

e sta e e § (G

L oty Lot s 5 S i ensdly gl v s
S 0,10 o30e s 3238 i Slprts 210l SV i3
0t osams Ayt 5 Sl sl 5 s ool Sl
B A L A i
35 s S i Sl o i 3B a3 3 S350
3 ey S a1 oo o 5 1> il S5 6 G
i o9 53 153900 Norwags 3 (ol 156 3% U9 3) ol o
B 1513 A5 sl 01 5>k S| QUsS @ WloLw Laules 03DLuks |,
Lt 3 031> U a5 9 05 53 sl o st

st i

Hausl,
a5 6 9 039 Jlao whl> vigaine el « woai b @S swglis
sl o @ abyo Olass 02,90 1 1 10 52, SIS U aaksus

el siaing (svloasl, Sl sguine 633381 03719 el 15 030 Lzl
528 SIS

() (58] st i sy e closs sl il =
B Ty et
i primp
it o i o
=S ——

D o S8 g g B i s i 5 )

s iau sl sl Slapsio





image133.png
o S e e e it

S 131 2 05 b 2590 L 1Sl Al o GV
5 Laile) Aogan Uirlla 155550 Sl il 25 5 55kasd] SUbtol
s il 5t S s 53 )] OS>t it £120
8D 53 b 3250 e ] | Gt 0 1B 2385 1> 51350
157 £, U Ll w50 03 2B 55 il 93 Lasa 8 0
o yo3a> 33 15,9, Ul 3 (el o 1% 050 ) ol 50
75 1515 a8 il ol oo <51 RS % AUlolas autas 018aka 1y

G Gshic . sy 0315 Ul 0810 (9E 0,3 2> Ll s ekt
P

Haisl,

S 8 5 030 fso Shls exigudun ol « ugai | oS suglic

wislis Gl @ by Olgis ls0 5l S 58 59, SIS | i

el sy (svloisly Sl aguinn 033381 0xis el 55 03 il
S SIS

[ oo 367 [ Gosn 1m | e

(Ul 85) Ll 39,5 a4 0 a0l sl
i llos iy s loss sl ol «
ol T oy 45§ Sl 0 o O
it > 003 (34 o
s 8 3 3l s Ao 3981 ol +
0 gl T oty 85§l 1 i 5
it o ey (57 0 il Pt

R e A e

(58] o e sl 5ol
e
i ey b 1951 02§
K er 5y il Slawg 3 8 oSy +
A 30 i o S bl S 520
s 5o S8 S«
bt 5L 5 o 1 4kt el S 30
st o
sk 5 S8 Sl
AL 5 s 580 Sl i iy Sl s 305
[
o a5 sl St
Sl 45§ S S e b o 053

o 8 S e 05

(] i cpmms'y o 50 S =
i 86 e - 45 o 000
s o

T

o

10





image134.gif




image135.png
T womLD BaNK. Home About Data Research Leaming News Projecs & Operatons Publcations Countries Topics  Englh ¥

Mg e o Foas os X

Qs [ IR

Explore. Create. Share: Development Data

DataBark is an analyis and visualsation tl that contins collectons of time sries data on 2 vaietyoftpic. ou can create your own
quere: generte ables,charts and maps; and easl save, embed. and share them Watc the (110l and réad the FAQS. Enfoy using
Datagank and et us know whatyou k!

WS poRULR
WHATS NEW Explore databases

el a hoaron cosmes
e [ — L

qumeypy r——

g onty ‘Sort by: Mos: Used » | Alphabesical | Las: Updated | View il detabases. R

cumryomra | | Destespemion [ e s e caren
M World Development indicators ) 7

erotmeogmrs || o ecpare s WD v iy Yo Sk el o eper gt om ity

fobonn e e e e i s s gk P ———
e ey

E 9 Dt o s Heth st G o S O

[ — P




image7.png




image136.png
DataBank

S s

stz Gorzry

WHATS NEW

B e
v

Qurwy By
-

Gy e
R

tersonuszms
—> e




image137.png
Gneronosne

DataBank  World Development Indicators

Varbies | Layoue s save snare Embea
+ oty Aosie 204 | seec 0




image138.png
Please clckon Apply Changes o view he repore.
& Couny

Gseres

e





image139.png
9 Map @ Metadata | & Downloadoptions =

Clear Selection | Add Country (7) Add Series @) Add Year (15)

Population, total *®

2013 2014 2015 2016 217
Algeria Y 38335620 391133130 98715280 406060520 413180000 3
Argentina Y 425399250 429815150 434177650 438474300 442710000
Amenla Y 2se3s000 2306200 29169500 25248160 28300000
Albania Y 28950520 28831040 28807030 28761010 28780000
Benin Y 100044510 102867120 105759520 108722980 111760000 i
« ——

Source: Poverty and Equity. Cick on a metadata Icon for original source Information to be used for cltation.
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Vector Autoregression Estimates
Date: 06/06/17 Time: 11:15
‘Sample (adjusted): 1959M05 1989M12
Included observations: 368 after adjustments
Standard errors in () & tstatistics in (]

P [ TB3
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Bayesian VAR Estimatos.
Dato:02/14/13 Time: 1630

‘Samplo (adjusted): 196004 157604

Included observatons: 73 after adjusiments
Prior type: Literman/Minnesota

Intial rosidual covariance: Urivarito AR
Hypor-parametors: Mu: 0, L1-0.1, 12: 099, L3: 1
Standard oros n ) & tstatistcs in ]
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Bayesian VAR Estimales
Dato: 0214/13 Time: 1405

Sample (adjusted): 196004 197804

Includad observations: 73 aftor adjustments
Priortype: Literman/Minnesota

Inta residual covariance: Diagonal VAR
Hyper-parametors: Mu: 0, L1: 01, L2: 099, L3: 1
Standard ertors in () & -statistcs in[]

DLINVESTMENT  DLINCOME  DLCONSUMPTION
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(0.07622) (0.01524) (0.01551)

(126547 [092950] (0.25524]
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[o24e08]  [0.49375] (0.78263]

DLINCOME1) 0150439 001551 0069184
(0.30206) (0.07717) (0.06183)

[049805]  [-0.25076] [1.11887)
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Dependent Variable: DLOG(SPX)
Method: ML ARCH - Normal distribution (Marquardt/ EViews legacy)
Date: 03/09/15 Time: 13:23
Sample: 1/02/1990 12/31/1999
Included observations: 2528
Convergence achieved after 26 iterations

Presample variance: backcast (parameter = 0.7)
GARCH = C(2) + C(3)'RESID(-1)"2 + C(4)* GARCH(-1)

Variable Coefficient ~ Std. Error ~ z-Statistic ~ Prob.
c 0000597 0000149  4.013882  0.0001
Variance Equation

c 583E-07  137E-07 4261215  0.0000
RESID(-1)"2 0053317 0005152  10.34861  0.0000
GARCH(-1) 0939955 0006125 1534702  0.0000
R-squared 0.000014  Mean dependent var 0000564
Adjusted R-squared 000014 S.D. dependent var 0.008888
S.E. of regression 0008889 Akaike info criterion -6.807476
Sum squared resid 0199649 Schwarz criterion -6.798243
Log likelihood 8608.650 Hannan-Quinn criter.  -6.804126

Durbin-Watson stat 1964029
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Dependent Variable: Y

Method: Quantile Regression (Median)
Date: 08/12009 Time: 11:46

sample: 1235

Included observations: 235
Huber Sandwich Standard Errors & Covariance
Sparsity method: Kernel (E panechnikov) using residuals.
Bandwidth method: Hall-Sheather, bw=0.15744
Estimation successfully identies unique optimal solution

Variable Coefficient ~ Std. Emor  tSiatistic  Prob.

c 8148225 2403494 3390158 00008

x 0560181 0031370  17.85707 00000

Pseudo R-squared 062055 Meandependentvar  624.1501

Adjusted R-squared 0618927 S.D. dependent var 2764570

SE. of regression 1208447 Objectve 8779966

Quantie dependent var 5825413  Restr. objective 23139.03

Sparsity 2093504 Quasi-LR statistic 5487091
Prob(QuasiLR stat)  0.000000
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Dependent Variable: Y
Method: Quantile Regression (Median)

Date: 08/1209 Time: 11:49

sample: 1235

Included observations: 235

Bootstrap Standard Errors & Govariance

Bootstrap method: MCMB-A, reps=500, rg=kn, soed-47500547
Sparsity method: Siddiqui using fitted quantiles

Bandwidih method: Hall-Sheather, bw=0.15744

Estimation successfully identfies unique optimal solution

Variable Coefficient  Std. Emor  1Siatistic  Prob,

c 8148225 2201534 3701158 00003

X 0560181 0023804 2353350  0.0000
Pseudo R-squared 062055 Meandependentvar  624.1501
Adjusted Rsquared 0618927 S.D. dependent var 2764570
SE. of regression 1208447 Objectve 8779966
Quantie dependent var 5825413 Restr. objectve 23139.03
Sparsity 2678284 Quasi-LR statistic 4289034

Prob(Quasi-LRstat) 0000000
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Sspace: SS_ARMA21
Method: Maximum likelihood (BFGS / Marquardt steps)
Date: 03/16/15 Time: 11:42

Sample: 1949M01 1960M12

Included observations: 144

Convergence achieved after 9 iterations

Coefficient covariance computed using outer product of
gradients

Coefficient ~ Std. Error ~ z-Statistic ~ Prob.

c(1) 5499767 0257517  21.35687  0.0000
c@) 0409013 0167201 2446239  0.0144
c@) 0547165  0.164608  3.324055  0.0009
c4) 1188382  0.141461  8.400799  0.0000
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Final State  RootMSE  z-Statistic  Prob.

sv1 0245396  0.084850  2.892117  0.0038
sv2 0319569  0.047896 6672101  0.0000
Log likelinood 1243367  Akaike info criterion -1.657454
Parameters 5 Schwarz criterion 554336
Diffuse priors 0 Hannan-Quinn criter. 615553
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System: SYS_UR

Estimation Method: Full Information Maximum Likelihood (Marquard)
Date: 08/1309 Time: 09:10

‘Sample: 19471971

Included observations: 25
Total system (balanced) observations 75
Convergence achieved atter 128 iterations

Coefficent  Std.Emor  zSttistic  Prob.
o) 0054983 0009353 5878830  0.0000
c@) 0035130 0035677 0984676 03248
c@) 0004136 0025616 0161445 08717
o) 0023633 0084444 0279867 0779
c() 0250180 0012019 2081592 0.0000
(6) 0014758 0024771 0595766 05513
o) 0083909 0032188 2606811  0.0091
c@) 0056411 0096020 0567493 05569
c@) 0043257 0007981 5420095  0.0000
c(10) 0007707 0012518  -0.615722 05381
(1) -0.002183 0020123  -0.108489 09136
c(12) 0035624 0061802 0576422 05643
Log likelihood 349.0026  Schwarz criterion 2637755
Avg.loglikelinood 4653769 Hannan-Quinn criter. 2680034
Akalke info criterion  -26.96261
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1.50E-16
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Wald Test:
System: SYS_UR
Null Hypothesis: G(3)=C(6), C(4)=C(10), C(8)=C(11)

Test Statistic Vaive of Probability

Chisquare 0.418796 3 09363

Null Hypothesis Summary;

Normalized Restriction (= 0) Value St Err.
c@3)-C6) 0010622 0039838
C(4)-C(10) 0031340 0077783
c(@®)-Cit1) 0058594 0090758

Restrictions are linear in coefficients.




